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OBJECTIVE 

 The major objective in introducing the Computer Skills course is to impart 

training for students in Microsoft Office which has different components like 

MS Word, MS Excel and Power point. The course is highly practice oriented 

rather than regular class room teaching. 

OUTCOMES: 

 To perform documentation 

 To perform accounting operations 
 To perform presentation skills 

 

UNIT - I 

Introductory concepts: History - Generation - Classification - Block diagram - Memory 
unit – CPU. 

UNIT - II 

Input Devices: Key board, Mouse and Scanner. Output devices: Monitor, Printer. 

Introduction to Operating systems & its features: DOS – UNIX – Windows. 

Introduction to Programming Languages: C, C++ and its features. 

UNIT - III 

Word Processing: Open, Save and close word document; Editing text – tools, 

formatting, bullets; Spell Checker - Document formatting – Paragraph alignment, 

indentation, headers and footers, numbering; printing – Preview, options, merge . 

 

UNIT - IV 

Spreadsheets: Excel – opening, entering text and data, formatting, navigating; 

Formulas – entering, handling and copying; Charts – creating, formatting and 

printing. 

UNIT - V 

Power point: Introduction to Power point - Features – Understanding slide types – 

creating & viewing slides – creating slide shows. Applying special object – 

including objects & pictures – Slide transition – Animation effects. 

TEXT BOOKS: 

1. Alexis Leon and Mathews Leon, "Fundamentals of information technology", Leon 
Press 1999, 2nd Edition. 

2. Peter Norton, “Introduction to Computers”, Tata McGraw Hill. 

REFERENCE BOOK: 

1. Jennifer Ackerman Kettel, Guy Hat-Davis and Curt Simmons, “Microsoft 2003”, 
Tata McGraw Hill. 

 

WEB REFERENCE: 

 NPTEL & MOOC courses titled Office Automation. 

 https://www.livewireindia.com/microsoftoffice_automation_software_training.p

hp 

 

https://www.livewireindia.com/microsoftoffice_automation_software_training.php
https://www.livewireindia.com/microsoftoffice_automation_software_training.php
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UNIT I 
HISTORY OF COMPUTERS 

The first counting device was used by the primitive people. They used sticks, stones and 

bones as counting tools. As human mind and technology improved with time more 

computing devices were developed. Some of the popular computing devices starting 

with the first to recent ones are described below; 

Abacus 

The history of computer begins with the birth of abacus which is believed to be the first 

computer. It is said that Chinese invented Abacus around 4,000 years ago. 

It was a wooden rack which has metal rods with beads mounted on them. The beads 

were moved by the abacus operator according to some rules to perform arithmetic 

calculations. Abacus is still used in some countries like China, Russia and Japan. An 

image of this tool is shown below; 

GENERATIONS OF COMPUTERS 

A generation of computers refers to the specific improvements in computer technology 

with time. In 1946, electronic pathways called circuits were developed to perform the 

counting. It replaced the gears and other mechanical parts used for counting in previous 

computing machines. 

In each new generation, the circuits became smaller and more advanced than the 

previous generation circuits. The miniaturization helped increase the speed, memory and 

power of computers. There are five generations of computers which are described 

below; 

First Generation Computers 

The first generation (1946-1959) computers were slow, huge and expensive. In these 

computers, vacuum tubes were used as the basic components of CPU and memory. 

These computers were mainly depended on batch operating system and punch cards. 

Magnetic tape and paper tape were used as output and input devices in this generation; 

Some of the popular first generation computers are; 

o ENIAC ( Electronic Numerical Integrator and Computer) 

o EDVAC ( Electronic Discrete Variable Automatic Computer) 

o UNIVACI( Universal Automatic Computer) 

o IBM-701 

o IBM-650 
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Second Generation Computers 

The second generation (1959-1965) was the era of the transistor computers. These 

computers used transistors which were cheap, compact and consuming less power; it 

made transistor computers faster than the first generation computers. 

In this generation, magnetic cores were used as the primary memory and magnetic disc 

and tapes were used as the secondary storage. Assembly language and programming 

languages like COBOL and FORTRAN, and Batch processing and multiprogramming 

operating systems were used in these computers. 

Some of the popular second generation computers are; 

o IBM 1620 

o IBM 7094 

o CDC 1604 

o CDC 3600 

o UNIVAC 1108 

Third Generation Computers 

The third generation computers used integrated circuits (ICs) instead of transistors. A 

single IC can pack huge number of transistors which increased the power of a computer 

and reduced the cost. The computers also became more reliable, efficient and smaller in 

size. These generation computers used remote processing, time-sharing, multi 

programming as operating system. Also, the high-level programming languages like 

FORTRON-II TO IV, COBOL, PASCAL PL/1, ALGOL-68 were used in this 

generation. 

Some of the popular third generation computers are; 

o IBM-360 series 

o Honeywell-6000 series 

o PDP(Personal Data Processor) 

o IBM-370/168 

o TDC-316 

Fourth Generation Computers 

The fourth generation (1971-1980) computers used very large scale integrated (VLSI) 

circuits; a chip containing millions of transistors and other circuit elements. These chips 

made this generation computers more compact, powerful, fast and affordable. These 

generation computers used real time, time sharing and distributed operating system. The 

programming languages like C, C++, DBASE were also used in this generation. 

Some of the popular fourth generation computers are; 
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o DEC 10 

o STAR 1000 

o PDP 11 

o CRAY-1(Super Computer) 

o CRAY-X-MP(Super Computer) 

Fifth Generation Computers 

In fifth generation (1980-till date) computers, the VLSI technology was replaced with 

ULSI (Ultra Large Scale Integration). It made possible the production of microprocessor 

chips with ten million electronic components. This generation computers used parallel 

processing hardware and AI (Artificial Intelligence) software. The programming 

languages used in this generation were C, C++, Java, .Net, etc. 

Some of the popular fifth generation computers are; 

o Desktop 

o Laptop 

o NoteBook 

o UltraBook 

o ChromeBook 

TYPES OF COMPUTER 

We can categorize computer in two ways: on the basis of data handling capabilities and 

size. 

On the basis of data handling capabilities, the computer is of three types: 

o Analogue Computer 

o Digital Computer 

o Hybrid Computer 

1) Analogue Computer 

Analogue computers are designed to process analogue data. Analogue data is 

continuous data that changes continuously and cannot have discrete values. We can say 

that analogue computers are used where we don't need exact values always such as 

speed, temperature, pressure and current. 

Analogue computers directly accept the data from the measuring device without first 

converting it into numbers and codes. They measure the continuous changes in physical 

quantity and generally render output as a reading on a dial or 

scale. Speedometer and mercury thermometer are examples of analogue computers. 

https://www.javatpoint.com/types-of-computer#Analogue
https://www.javatpoint.com/types-of-computer#Digital
https://www.javatpoint.com/types-of-computer#Hybrid
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Advantages of using analogue computers: 

o It allows real-time operations and computation at the same time and continuous 

representation of all data within the rage of the analogue machine. 

o In some applications, it allows performing calculations without taking the help of 

transducers for converting the inputs or outputs to digital electronic form and 

vice versa. 

o The programmer can scale the problem for the dynamic range of the analogue 

computer. It provides insight into the problem and helps understand the errors 

and their effects. 

Types of analogue computers: 

o Slide Rules: It is one of the simplest types of mechanical analogue computers. 

It was developed to perform basic mathematical calculations. It is made of two 

rods. To perform the calculation, the hashed rod is slid to line up with the 

markings on another rod. 

o Differential Analysers: It was developed to perform differential calculations. It 

performs integration using wheel-and-disc mechanisms to solve differential 

calculations. 

o Castle Clock: It was invented by Al-Jarazi. It was able to save programming 

instructions. Its height was around 11 feet and it was provided with the display of 

time, the zodiac, and the solar and lunar orbits. This device also could allow 

users to set the length of the day as per the current season. 

o Electronic Analogue Computer: In this type of analogue computer, electrical 

signals flow through capacitors and resistors to simulate physical phenomena. 

Here, the mechanical interaction of components does not take place. The voltage 

of the electrical signal generates the appropriate displays. 

2) Digital Computer 

Digital computer is designed to perform calculations and logical operations at high 

speed. It accepts the raw data as input in the form of digits or binary numbers (0 and 1) 

and processes it with programs stored in its memory to produce the output. All modern 

computers like laptops, desktops including smartphones that we use at home or office 

are digital computers. 

Advantages of digital computers: 

o It allows you to store a large amount of information and to retrieve it easily 

whenever you need it. 

o You can easily add new features to digital systems more easily. 

o Different applications can be used in digital systems just by changing the 

program without making any changes in hardware 
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o The cost of hardware is less due to the advancement in the IC technology. 

o It offers high speed as the data is processed digitally. 

o It is highly reliable as it uses error correction codes. 

o Reproducibility of results is higher as the output is not affected by noise, 

temperature, humidity, and other properties of its components. 

3) Hybrid Computer 

Hybrid computer has features of both analogue and digital computer. It is fast like an 

analogue computer and has memory and accuracy like digital computers. It can process 

both continuous and discrete data. It accepts analogue signals and convert them into 

digital form before processing. So, it is widely used in specialized applications where 

both analogue and digital data is processed. For example, a processor is used in petrol 

pumps that converts the measurements of fuel flow into quantity and price. Similarly, 

they are used in airplanes, hospitals, and scientific applications. 

Advantages of using hybrid computers: 

o Its computing speed is very high due to the all-parallel configuration of the 

analogue subsystem. 

o It produces precise and quick results that are more accurate and useful. 

o It has the ability to solve and manage big equation in real-time. 

o It helps in the on-line data processing. 

 

ON THE BASIS OF SIZE, THE COMPUTER CAN BE OF FIVE TYPES: 

1) Supercomputer 

Supercomputers are the biggest and fastest computers. They are designed to process 

huge amount of data. A supercomputer can process trillions of instructions in a second. 

It has thousands of interconnected processors. 

Supercomputers are particularly used in scientific and engineering applications such as 

weather forecasting, scientific simulations and nuclear energy research. The first 

supercomputer was developed by Roger Cray in 1976. 

Characteristics or applications of supercomputers: 

o It has the ability to decrypt your password to enhance protection for security 

reasons. 

o It produces excellent results in animations. 

o It is used for virtual testing of nuclear weapons and critical medical tests. 
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o It can study and understand climate patterns and forecast weather conditions. It 

can run in NOAA's system (National Oceanic and Atmospheric Administration) 

that can execute any type of simple and logical data. 

o It helps in designing the flight simulators for pilots at the beginner level for their 

training. 

o It helps in extracting useful information from data storage centres or cloud 

system. For example, in insurance companies. 

o It has played a vital role in managing the online currency world such as stock 

market and bitcoin. 

o It helps in the diagnosis of various critical diseases and in producing accurate 

results in brain injuries, strokes, etc. 

o It helps in scientific research areas by accurately analysing data obtained from 

exploring the solar system, satellites, and movement of Earth. 

o It also used in a smog control system where it predicts the level of fog and other 

pollutants in the atmosphere. 

2) Mainframe computer 

Mainframe computers are designed to support hundreds or thousands of users 

simultaneously. They can support multiple programs at the same time. It means they can 

execute different processes simultaneously. These features of mainframe computers 

make them ideal for big organizations like banking and telecom sectors, which need to 

manage and process high volume of data. 

Mainframe computers are designed to support hundreds or thousands of users 

simultaneously. They can support multiple programs at the same time. It means they 

can execute different processes simultaneously. These features of mainframe computers 

make them ideal for big organizations like banking and telecom sectors, which need to 

manage and process a high volume of data that requires integer operations such as 

indexing, comparisons, etc. 

Characteristics of Mainframe Computers: 

o It can process huge amount of data, e.g. millions of transactions in a second in 

the banking sector. 

o It has a very long life. It can run smoothly for up to 50 years after proper 

installation. 

o It gives excellent performance with large scale memory management. 

o It has the ability to share or distribute its workload among other processors and 

input/output terminals. 

o There are fewer chances of error or bugs during processing in mainframe 

computers. If any error occurs it can fix it quickly without affecting the 

performance. 
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o It has the ability to protect the stored data and other ongoing exchange of 

information and data. 

Applications of mainframe computers: 

o In health care, it enabled hospitals to maintain a record of their millions of 

patients in order to contact them for treatment or related to their appointment, 

medicine updates or disease updates. 

o In the field of defence, it allows the defence departments to share a large amount 

of sensitive information with other branches of defence. 

o In the field of education, it helps big universities to store, manage and retrieve 

data related to their courses, admissions, students, teachers, employees and 

affiliated schools and colleges. 

o In the retail sector, the retail companies that have a huge customer base and 

branches use mainframe computers to handle and execute information related to 

their inventory management, customer management, and huge transactions in a 

short duration. 

3) Miniframe or Minicomputer 

It is a midsize multiprocessing computer. It consists of two or more processors and can 

support 4 to 200 users at one time. Miniframe computers are used in institutes and 

departments for tasks such as billing, accounting and inventory management. A 

minicomputer lies between the mainframe and microcomputer as it is smaller than 

mainframe but larger than a microcomputer. 

Characteristics of miniframe or minicomputer: 

o It is light weight that makes it easy to carry and fit anywhere. 

o It is less expensive than mainframe computers. 

o It is very fast compared to its size. 

o It remains charged for a long time. 

o It does not require a controlled operational environment. 

Applications of minicomputers: 

A minicomputer is mainly used to perform three primary functions, which are as 

follows: 

o Process control: It was used for process control in manufacturing. It mainly 

performs two primary functions that are collecting data and feedback. If any 

abnormality occurs in the process, it is detected by the minicomputer and 

necessary adjustments are made accordingly. 
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o Data management: It is an excellent device for small organizations to collect, 

store and share data. Local hospitals and hotels can use it to maintain the records 

of their patients and customers respectively. 

o Communications Portal: It can also play the role of a communication device in 

larger systems by serving as a portal between a human operator and a central 

processor or computer. 

4) Workstation 

Workstation is a single user computer that is designed for technical or scientific 

applications. It has a faster microprocessor, a large amount of RAM and high speed 

graphic adapters. It generally performs a specific job with great expertise; accordingly, 

they are of different types such as graphics workstation, music workstation and 

engineering design workstation. 

Characteristics of workstation computer: 

o It is a high-performance computer system designed for a single user for business 

or professional use. 

o It has larger storage capacity, better graphics, and more powerful CPU than a 

personal computer. 

o It can handle animation, data analysis, CAD, audio and video creation and 

editing. 

Any computer that has the following five features, can be termed as a workstation or can 

be used as a workstation. 

o Multiple Processor Cores: It has more processor cores than simple laptops or 

computers. 

o ECC RAM: It is provided with Error-correcting code memory that can fix 

memory errors before they affect the system's performance. 

o RAID (Redundant Array of Independent Disks): It refers to multiple internal 

hard drives to store or process data. RAID can be of different types, for example, 

there can be multiple drives to process data or mirrored drives where if one drive 

does not work than other starts functioning. 

o SSD: It is better than conventional hard-disk drives. It does not have moving 

parts, so the chances of physical failure are very less. 

o Optimized, Higher end GPU: It reduces the load on CPU. E.g., CPU has to do 

less work while processing the screen output. 
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5) Microcomputer 

Microcomputer is also known as a personal computer. It is a general-purpose computer 

that is designed for individual use. It has a microprocessor as a central processing unit, 

memory, storage area, input unit and output unit. Laptops and desktop computers are 

examples of microcomputers. They are suitable for personal work that may be making 

an assignment, watching a movie, or at office for office work. 

Characteristics of a microcomputer: 

o It is the smallest in size among all types of computers. 

o A limited number of software can be used. 

o It is designed for personal work and applications. Only one user can work at a 

time. 

o It is less expansive and easy to use. 

o It does not require the user to have special skills or training to use it. 

o Generally, comes with single semiconductor chip. 

o It is capable of multitasking such as printing, scanning, browsing, watching 

videos, etc. 

COMPUTER COMPONENTS 

There are 5 main computer components that are given below: 

o Input Devices 

o CPU 

o Output Devices 

o Primary Memory 

o Secondary Memory 

 

The operations of computer components are given below: 
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1) Inputting: It is the process of entering raw data, instructions and information into the 

computer. It is performed with the help of input devices. 

2) Storing: The computer has primary memory and secondary storage to store data and 

instructions. It stores the data before sending it to CPU for processing and also stores the 

processed data before displaying it as output. 

3) Processing: It is the process of converting the raw data into useful information. This 

process is performed by the CPU of the computer. It takes the raw data from storage, 

processes it and then sends back the processed data to storage. 

4) Outputting: It is the process of presenting the processed data through output devices 

like monitor, printer and speakers. 

5) Controlling: This operation is performed by the control unit that is part of CPU. The 

control unit ensures that all basic operations are executed in a right manner and 

sequence. 

COMPUTER MEMORY 

The computer memory holds the data and instructions needed to process raw data and 

produce output. The computer memory is divided into large number of small parts 

known as cells. Each cell has a unique address which varies from 0 to memory size 

minus one. 

Computer memory is of two types: Volatile (RAM) and Non-volatile (ROM). The 

secondary memory (hard disk) is referred as storage not memory. 

But, if we categorize memory on behalf of space or location, it is of four types: 

o Register memory 

o Cache memory 

o Primary memory 

o Secondary memory 

 FUNCTIONALITIES OF A COMPUTER 

1. High Speed 

 Computer is a very fast device. 

 It is capable of performing calculation of very large amount of data. 

 The computer has units of speed in microsecond, nanosecond, and even the 

picosecond. 

 It can perform millions of calculations in a few seconds as compared to man who 

will spend many months to perform the same task. 

2. Accuracy 

 In addition to being very fast, computers are very accurate. 

 The calculations are 100% error free. 

 Computers perform all jobs with 100% accuracy provided that the input is 

correct. 
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3. Storage Capability 

 Memory is a very important characteristic of computers. 

 A computer has much more storage capacity than human beings. 

 It can store large amount of data. 

 It can store any type of data such as images, videos, text, audio, etc. 

 

4. Diligence 

 Unlike human beings, a computer is free from monotony, tiredness, and lack of 

concentration. 

 It can work continuously without any error and boredom. 

 It can perform repeated tasks with the same speed and accuracy. 

 

5. Versatility 

 A computer is a very versatile machine. 

 A computer is very flexible in performing the jobs to be done. 

 This machine can be used to solve the problems related to various fields. 

 At one instance, it may be solving a complex scientific problem and the very 

next moment it may be playing a card game. 

 

6. Reliability 

 A computer is a reliable machine. 

 Modern electronic components have long lives. 

 Computers are designed to make maintenance easy. 

 

7. Automation 

 Computer is an automatic machine. 

 Automation is the ability to perform a given task automatically. Once the 

computer receives a program i.e., the program is stored in the computer memory, 

then the program and instruction can control the program execution without 

human interaction. 

 Reduction in Paper Work and Cost 

 The use of computers for data processing in an organization leads to reduction in 

paper work and results in speeding up the process. 

 As data in electronic files can be retrieved as and when required, the problem of 

maintenance of large number of paper files gets reduced. 

 Though the initial investment for installing a computer is high, it substantially 

reduces the cost of each of its transaction. 

Disadvantages of Computers 

Following are certain disadvantages of computers. 

 

No I.Q. 

 A computer is a machine that has no intelligence to perform any task. 

 Each instruction has to be given to the computer. 

 A computer cannot take any decision on its own. 
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Dependency 

It functions as per the user’s instruction, thus it is fully dependent on humans. 

 

Environment 

The operating environment of the computer should be dust free and suitable. 

 

No Feeling 

 Computers have no feelings or emotions. 

 It cannot make judgment based on feeling, taste, experience, and knowledge 

unlike humans. 

 

Applications of Computer  

Business 

 A computer has high speed of calculation, diligence, accuracy, reliability, or 

versatility which has made it an integrated part in all business organizations. 

 Computer is used in business organizations for − 

 Payroll calculations 

 Budgeting 

 Sales analysis 

 Financial forecasting 

 Managing employee database 

 Maintenance of stocks, etc. 

Banking 

 Computer Banking 

 Today, banking is almost totally dependent on computers. 

 Banks provide the following facilities − 

 Online accounting facility, which includes checking current balance, making 

deposits and overdrafts, checking interest charges, shares, and trustee records. 

 ATM machines which are completely automated are making it even easier for 

customers to deal with banks. 

 

Insurance 

 Computer Insurance 

 Insurance companies are keeping all records up-to-date with the help of 

computers. Insurance companies, finance houses, and stock broking firms are 

widely using computers for their concerns. 

 Insurance companies are maintaining a database of all clients with information 

showing − 

 Procedure to continue with policies 

 Starting date of the policies 

 Next due installment of a policy 

 Maturity date 

 Interests due 

 Survival benefits 

 Bonus 
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Education - Computer Educational 

 The computer helps in providing a lot of facilities in the education system. 

 The computer provides a tool in the education system known as CBE (Computer 

Based Education). 

 CBE involves control, delivery, and evaluation of learning. 

 Computer education is rapidly increasing the graph of number of computer 

students. 

 There are a number of methods in which educational institutions can use a 

computer to educate the students. 

 It is used to prepare a database about performance of a student and analysis is 

carried out on this basis. 

Marketing 

 In marketing, uses of the computer are following − 

 Computer Marketing 

 Advertising − With computers, advertising professionals create art and graphics, 

write and revise copy, and print and disseminate ads with the goal of selling 

more products. 

 Home Shopping − Home shopping has been made possible through the use of 

computerized catalogues that provide access to product information and permit 

direct entry of orders to be filled by the customers. 

 

Healthcare 

 Computers have become an important part in hospitals, labs, and dispensaries. 

They are being used in hospitals to keep the record of patients and medicines. It 

is also used in scanning and diagnosing different diseases. ECG, EEG, 

ultrasounds and CT scans, etc. are also done by computerized machines. 

 Following are some major fields of health care in which computers are used. 

 

 Computer Healthcare 

 Diagnostic System − Computers are used to collect data and identify the cause of 

illness. 

 Lab-diagnostic System − All tests can be done and the reports are prepared by 

computer. 

 Patient Monitoring System − These are used to check the patient's signs for 

abnormality such as in Cardiac Arrest, ECG, etc. 

 Pharma Information System − Computer is used to check drug labels, expiry 

dates, harmful side effects, etc. 

 Surgery − Nowadays, computers are also used in performing surgery. 

 

Engineering Design 

 Computers are widely used for Engineering purpose. 

 One of the major areas is CAD (Computer Aided Design) that provides creation 

and modification of images. Some of the fields are − 

 Computer Engineering 

 Structural Engineering − Requires stress and strain analysis for design of ships, 

buildings, budgets, airplanes, etc. 
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 Industrial Engineering − Computers deal with design, implementation, and 

improvement of integrated systems of people, materials, and equipment. 

 Architectural Engineering − Computers help in planning towns, designing 

buildings, determining a range of buildings on a site using both 2D and 3D 

drawings. 

 

Military - Computer Military 

Computers are largely used in defence. Modern tanks, missiles, weapons, etc. Military 

also employs computerized control systems. Some military areas where a computer has 

been used are  

 Missile Control 

 Military Communication 

 Military Operation and Planning 

 Smart Weapons 

 Communication 

 Communication is a way to convey a message, an idea, a picture, or speech that 

is received and understood clearly and correctly by the person for whom it is 

meant.  

Computer Communication 

 E-mail 

 Chatting 

 Usenet 

 FTP 

 Telnet 

 Video-conferencing 

 

Government - Computer Government 

 Budgets 

 Sales tax department 

 Income tax department 

 Computation of male/female ratio 

 Computerization of voters lists 

 Computerization of PAN card 

 Weather forecasting 

 

CENTRAL PROCESSING UNIT (CPU) 

A Central Processing Unit is also called a processor, central processor, or 

microprocessor. It carries out all the important functions of a computer. It receives 

instructions from both the hardware and active software and produces output 

accordingly. It stores all important programs like operating systems and application 

software. CPU also helps Input and output devices to communicate with each other. 

Owing to these features of CPU, it is often referred to as the brain of the computer. 

CPU is installed or inserted into a CPU socket located on the motherboard. Furthermore, 

it is provided with a heat sink to absorb and dissipate heat to keep the CPU cool and 

functioning smoothly. 
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Generally, a CPU has three components: 

o ALU (Arithmetic Logic Unit) 

o Control Unit 

o Memory or Storage Unit 

 

Control Unit: It is the circuitry in the control unit, which makes use of electrical signals 

to instruct the computer system for executing already stored instructions. It takes 

instructions from memory and then decodes and executes these instructions. So, it 

controls and coordinates the functioning of all parts of the computer. The Control Unit's 

main task is to maintain and regulate the flow of information across the processor. It 

does not take part in processing and storing data. 

ALU: It is the arithmetic logic unit, which performs arithmetic and logical functions. 

Arithmetic functions include addition, subtraction, multiplication division, and 

comparisons. Logical functions mainly include selecting, comparing, and merging the 

data. A CPU may contain more than one ALU. Furthermore, ALUs can be used for 

maintaining timers that help run the computer. 

Memory or Storage Unit/ Registers: It is called Random access memory (RAM). It 

temporarily stores data, programs, and intermediate and final results of processing. So, it 

acts as a temporary storage area that holds the data temporarily, which is used to run the 

computer. 

What is CPU Clock Speed? 

The clock speed of a CPU or a processor refers to the number of instructions it can 

process in a second. It is measured in gigahertz. For example, a CPU with a clock speed 

of 4.0 GHz means it can process 4 billion instructions in a second. 

Types of CPU: 

CPUs are mostly manufactured by Intel and AMD, each of which manufactures its own 

types of CPUs. In modern times, there are lots of CPU types in the market. Some of the 

basic types of CPUs are described below: 
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Single Core CPU: Single Core is the oldest type of computer CPU, which was used in 

the 1970s. It has only one core to process different operations. It can start only one 

operation at a time; the CPU switches back and forth between different sets of data 

streams when more than one program runs. So, it is not suitable for multitasking as the 

performance will be reduced if more than one application runs. The performance of 

these CPUs is mainly dependent on the clock speed. It is still used in various devices, 

such as smartphones. 

Dual Core CPU: As the name suggests, Dual Core CPU contains two cores in a single 

Integrated Circuit (IC). Although each core has its own controller and cache, they are 

linked together to work as a single unit and thus can perform faster than the single-core 

processors and can handle multitasking more efficiently than Single Core processors. 

Quad Core CPU: This type of CPU comes with two dual-core processors in one 

integrated circuit (IC) or chip. So, a quad-core processor is a chip that contains four 

independent units called cores. These cores read and execute instructions of CPU. The 

cores can run multiple instructions simultaneously, thereby increases the overall speed 

for programs that are compatible with parallel processing. 

Quad Core CPU uses a technology that allows four independent processing units (cores) 

to run in parallel on a single chip. Thus by integrating multiple cores in a single CPU, 

higher performance can be generated without boosting the clock speed. However, the 

performance increases only when the computer's software supports multiprocessing. The 

software which supports multiprocessing divides the processing load between multiple 

processors instead of using one processor at a time. 

History of CPU: 

Some of the important events in the development of CPU since its invention till date 

are as follows: 

o In 1823, Baron Jons Jackob Berzelius discovered silicon that is the main 

component of CPU till date. 

o In 1903, Nikola Tesla got gates or switches patented, which are electrical logic 

circuits. 

o In December 1947, John Bardeen, William Shockley, and Walter Brattain 

invented the first transistor at the Bell Laboratories and got it patented in 1948. 

o In 1958, the first working integrated circuit was developed by Robert Noyce and 

Jack Kilby. 

o In 1960, IBM established the first mass-production facility for transistors in New 

York. 

o In 1968, Robert Noyce and Gordon Moore founded Intel Corporation. 

o AMD (Advanced Micro Devices) was founded in May 1969. 

o In 1971, Intel introduced the first microprocessor, the Intel 4004, with the help of 

Ted Hoff. 
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o In 1972, Intel introduced the 8008 processor; in 1976, Intel 8086 was introduced, 

and in June 1979, Intel 8088 was released. 

o In 1979, a 16/32-bit processor, the Motorola 68000, was released. Later, it was 

used as a processor for the Apple Macintosh and Amiga computers. 

o In 1987, Sun introduced the SPARC processor. 

o In March 1991, AMD introduced the AM386 microprocessor family. 

o In March 1993, Intel released the Pentium processor. In 1995, Cyrix introduced 

the Cx5x86 processor to give competition to Intel Pentium processors. 

o In January 1999, Intel introduced the Celeron 366 MHz and 400 MHz 

processors. 

o In April 2005, AMD introduced its first dual-core processor. 

o In 2006, Intel introduced the Core 2 Duo processor. 

o In 2007, Intel introduced different types of Core 2 Quad processors. 

o In April 2008, Intel introduced the first series of Intel Atom processors, the Z5xx 

series. They were single-core processors with a 200 MHz GPU. 

o In September 2009, Intel released the first Core i5 desktop processor with four 

cores. 

o In January 2010, Intel released many processors such as Core 2 Quad processor 

Q9500, first Core i3 and i5 mobile processors, first Core i3 and i5 desktop 

processors. In the same year in July, it released the first Core i7 desktop 

processor with six cores. 

o In June 2017, Intel introduced the first Core i9 desktop processor. 

o In April 2018, Intel released the first Core i9 mobile processor. 

 

UNIT II 
 

INPUT DEVICES 

Input device enables the user to send data, information, or control signals to a computer. 

The Central Processing Unit (CPU) of a computer receives the input and processes it to 

produce the output. 

Some of the popular input devices are: 

1. Keyboard 

2. Mouse 

3. Scanner 

4. Joystick 

https://www.javatpoint.com/input-devices#Keyboard
https://www.javatpoint.com/input-devices#Mouse
https://www.javatpoint.com/input-devices#Scanner
https://www.javatpoint.com/input-devices#Joystick
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5. Light Pen 

6. Digitizer 

7. Microphone 

8. Magnetic Ink Character Recognition (MICR) 

9. Optical Character Reader (OCR) 

10. Digital Camera 

11. Paddle 

12. Steering Wheel 

13. Gesture recognition devices 

14. Light Gun 

15. Touch Pad 

16. Remote 

17. Touch screen 

18. VR 

19. Webcam 

20. Biometric Devices 

 

1) Keyboard 

The keyboard is a basic input device that is used to enter data into a computer or any 

other electronic device by pressing keys. It has different sets of keys for letters, numbers, 

characters, and functions. Keyboards are connected to a computer through USB or a 

Bluetooth device for wireless communication. 

2) Mouse 

The mouse is a hand-held input device which is used to move cursor or pointer across 

the screen. It is designed to be used on a flat surface and generally has left and right 

button and a scroll wheel between them. Laptop computers come with a touchpad that 

works as a mouse. It lets you control the movement of cursor or pointer by moving your 

finger over the touchpad. Some mouse comes with integrated features such as extra 

buttons to perform different buttons. 

The mouse was invented by Douglas C. Engelbart in 1963. Early mouse had a roller ball 

integrated as a movement sensor underneath the device. Modern mouse devices come 

with optical technology that controls cursor movements by a visible or invisible light 

beam. A mouse is connected to a computer through different ports depending on the type 

of computer and type of a mouse. 

https://www.javatpoint.com/input-devices#LightPen
https://www.javatpoint.com/input-devices#Digitizer
https://www.javatpoint.com/input-devices#Microphone
https://www.javatpoint.com/input-devices#MICR
https://www.javatpoint.com/input-devices#OCR
https://www.javatpoint.com/input-devices#DigitalCamera
https://www.javatpoint.com/input-devices#Paddle
https://www.javatpoint.com/input-devices#SteeringWheel
https://www.javatpoint.com/input-devices#GestureRecognition
https://www.javatpoint.com/input-devices#LightGun
https://www.javatpoint.com/input-devices#TouchPad
https://www.javatpoint.com/input-devices#Remote
https://www.javatpoint.com/input-devices#TouchScreen
https://www.javatpoint.com/input-devices#VR
https://www.javatpoint.com/input-devices#Webcam
https://www.javatpoint.com/input-devices#BiometricDevices
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Common types of the mouse: 

(i) Trackball Mouse:  

It is a stationary input device that has ball mechanism to move the pointer or cursor on 

the screen. The ball is half inserted in the device and can be easily rolled with finger, 

thumb or the palm to move the pointer on the screen. The device has sensor to detect the 

rotation of ball. It remains stationary; you don't need to move it on the operating surface. 

So, it is an ideal device if you have limited desk space as you don't need to move it like a 

mouse. 

ii) Mechanical Mouse: 

 

 It has a system of a ball and several 

rollers to track its movement. It is a corded type of mouse. A mechanical mouse can be 

used for high performance. The drawback is that they tend to get dust into the mechanics 

and thus require regular cleaning. 
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iii) Optical Mouse: 

 

An optical mouse uses optical electronics to track its movement. It is more reliable than 

a mechanical mouse and also requires less maintenance. However, its performance is 

affected by the surface on which it is operated. Plain non-glossy mouse mat should be 

used for best results. The rough surface may cause problems for the optical recognition 

system, and the glossy surface may reflect the light wrongly and thus may cause tracking 

issues. 

iv) Cordless or Wireless Mouse: 

 

As the name suggests, this type of mouse lacks cable and uses wireless technology such 

as IrDA (infrared) or radio (Bluetooth or Wi-Fi) to control the movement of the cursor. 

It is used to improve the experience of using a mouse. It uses batteries for its power 

supply. 

3) Scanner 

The scanner uses the pictures and pages of text as input. It scans the picture or a 

document. The scanned picture or document then converted into a digital format or file 

and is displayed on the screen as an output. It uses optical character recognition 

techniques to convert images into digital ones. Some of the common types of scanners 

are as follows: 
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Types of Scanner: 

i) Flatbed Scanner: 

 

It has a glass pane and a moving optical CIS or CCD array. The light illuminates the 

pane, and then the image is placed on the glass pane. The light moves across the glass 

pane and scans the document and thus produces its digital copy. You will need a 

transparency adapter while scanning transparent slides. 

ii) Handheld Scanner: 

 

It is a small manual scanning device which is held by hand and is rolled over a flat 

image that is to be scanned. The drawback in using this device is that the hand should be 

steady while scanning; otherwise, it may distort the image. One of the commonly used 

handheld scanners is the barcode scanner which you would have seen in shopping stores. 
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iii) Sheetfed Scanner: 

 

In this scanner, the document is inserted into the slot provided in the scanner. The main 

components of this scanner include the sheet-feeder, scanning module, and calibration 

sheet. The light does not move in this scanner. Instead, the document moves through the 

scanner. It is suitable for scanning single page documents, not for thick objects like 

books, magazines, etc. 

iv) Drum Scanner: 

 

Drum scanner has a photomultiplier tube (PMT) to scan images. It does not have a 

charge-coupled device like a flatbed scanner. The photomultiplier tube is extremely 

sensitive to light. The image is placed on a glass tube, and the light moves across the 

image, which produces a reflection of the image which is captured by the PMT and 

processed. These scanners have high resolution and are suitable for detailed scans. 

v) Photo Scanner: 
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It is designed to scan photographs. It has high resolution and color depth, which are 

required for scanning photographs. Some photo scanners come with in-built software for 

cleaning and restoring old photographs. 

4) Joystick 

 

A joystick is also a pointing input device like a mouse. It is made up of a stick with a 

spherical base. The base is fitted in a socket that allows free movement of the stick. The 

movement of stick controls the cursor or pointer on the screen. 

The frist joystick was invented by C. B. Mirick at the U.S. Naval Research Laboratory. 

A joystick can be of different types such as displacement joysticks, finger-operated 

joysticks, hand operated, isometric joystick, and more. In joystick, the cursor keeps 

moving in the direction of the joystick unless it is upright, whereas, in mouse, the cursor 

moves only when the mouse moves. 
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5) Light Pen 

 

A light pen is a computer input device that looks like a pen. The tip of the light pen 

contains a light-sensitive detector that enables the user to point to or select objects on the 

display screen. Its light sensitive tip detects the object location and sends the 

corresponding signals to the CPU. It is not compatible with LCD screens, so it is not in 

use today. It also helps you draw on the screen if needed. The first light pen was 

invented around 1955 as a part of the Whirlwind project at the Massachusetts Institute of 

Technology (MIT).  

6) Digitizer 

Digitizer is a computer input device that has a flat surface and usually comes with a 

stylus. It enables the user to draw images and graphics using the stylus as we draw on 

paper with a pencil. The images or graphics drawn on the digitizer appear on the 

computer monitor or display screen. The software converts the touch inputs into lines 

and can also convert handwritten text to typewritten words. 

It can be used to capture handwritten signatures and data or images from taped papers. 

Furthermore, it is also used to receive information in the form of drawings and send 

output to a CAD (Computer-aided design) application and software like AutoCAD. 

Thus, it allows you to convert hand-drawn images into a format suitable for computer 

processing. 

 

https://www.javatpoint.com/central-processing-unit
https://www.javatpoint.com/lcd-full-form
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7) Microphone 

 

The microphone is a computer input device that is used to input the sound. It receives 

the sound vibrations and converts them into audio signals or sends to a recording 

medium. The audio signals are converted into digital data and stored in the computer. 

The microphone also enables the user to telecommunicate with others. It is also used to 

add sound to presentations and with webcams for video conferencing. A microphone can 

capture audio waves in different ways; accordingly the three most common types are 

described below: 

i) Dynamic: 

It is the most commonly used microphone with a simple design. It has a magnet which is 

wrapped by a metal coil and a thin sheet on the front end of the magnet. The sheet 

transfers vibrations from sound waves to the coil and from coil to electric wires which 

transmit the sound like an electrical signal. 
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ii) Condenser: 

 

It is designed for audio recording and has a very sensitive and flat frequency response. It 

has a front plate called diaphragm and a back plate parallel to the front plate. When 

sound hits the diaphragm, it vibrates the diaphragm and alters the distance between the 

two plates. The changes in distance are transmitted as electric signals. 

iii) Ribbon: 

It is known for its reliability. It has a thin ribbon made of aluminum, duraluminum, or 

nanofilm suspended in a magnetic field. The sound waves cause vibrations in the ribbon, 

which generate a voltage proportional to the velocity of the vibration. The voltage is 

transmitted as an electrical signal. Early ribbon microphones had a transformer to 

increase the output voltage, but modern ribbon microphones come with advanced 

magnets to produce a strong signal. 
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8) Magnetic Ink Character Recognition (MICR) 

 

MICR computer input device is designed to read the text printed with magnetic ink. 

MICR is a character recognition technology that makes use of special magnetized ink 

which is sensitive to magnetic fields. It is widely used in banks to process the cheques 

and other organizations where security is a major concern. It can process three hundred 

cheques in a minute with hundred-percent accuracy. The details on the bottom of the 

cheque (MICR No.) are written with magnetic ink. A laser printer with MICR toner can 

be used to print the magnetic ink. 

The device reads the details and sends to a computer for processing. A document printed 

in magnetic ink is required to pass through a machine which magnetizes the ink, and the 

magnetic information is then translated into characters. 
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9) Optical Character Reader (OCR) 

 

OCR computer input device is designed to convert the scanned images of handwritten, 

typed or printed text into digital text. It is widely used in offices and libraries to convert 

documents and books into electronic files. 

It processes and copies the physical form of a document using a scanner. After copying 

the documents, the OCR software converts the documents into a two-color (black and 

white), version called bitmap. Then it is analyzed for light and dark areas, where the 

dark areas are selected as characters, and the light area is identified as background. It is 

widely used to convert hard copy legal or historic documents into PDFs. The converted 

documents can be edited if required like we edit documents created in ms word. 

10) Digital camera: 

 

It is a digital device as it captures images and records videos digitally and then stores 

them on a memory card. It is provided with an image sensor chip to capture images, as 

opposed to film used by traditional cameras. Besides this, a camera that is connected to 

your computer can also be called a digital camera. 

It has photosensors to record light that enters the camera through the lens. When the 

light strikes the photosensors, each of the sensors returns the electrical current, which is 

used to create the images. 
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11) Paddle: 

 

It is a simple input device that is widely used in games. It is a wheel that is held by hand 

and looks like a volume knob on a stereo that is used to increase or decrease the volume. 

Paddle moves or controls cursor or any other objects in the game in a back-and-forth 

motion. It is widely used as an alternative to the joystick. Besides this, the term paddle 

also refers to many handheld devices designed to control a function in an electronic 

device, computer, etc. 

12) Steering wheel: 

 

It is used as an input device in racing video games such as car racing games or in driving 

programs as virtual simulators to steer a vehicle. It works like the real steering wheel by 

allowing you to take a right or left turn. A steering wheel may be provided with 

acceleration and brake pedal devices and a mechanism for shifting gears. Thus, it makes 

racing games more adventurous and entertaining. 

13) Gesture recognition devices: 
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These devices take human gestures as input. There are many such devices that respond 

to gestures. For example, Kinect is one such device that observes the movement of a 

player's body and interprets these movements as inputs to video games. This feature is 

also available in certain tablets and smartphones where you can perform certain tasks 

such as taking pictures using finger gestures such as swiping, pinching, etc. 

14) Light Gun: 

 

As the name suggests, it is a pointing input device that is designed to point at and shoot 

the targets on the screen in a video game, or arcade, etc. The light gun was used for the 

first time on the MIT Whirwind computer. When the gun is pointed at the target on the 

screen and the trigger is pulled, the screen goes blank for a fraction of a second. During 

this moment, the photodiode, which is present in the barrel, determines where the gun is 

pointed. For example, shooting ducks in a duck hunt game. 

15) Touchpad: 

 

It is usually found in laptops as a substitute for the mouse. It allows you to move or 

control the cursor on the screen using your finger. Just like a mouse, it also has two 

buttons for right and left click. Using the touchpad, you can perform all the tasks that 

you do with a mouse, such as selecting an object on the screen, copy, paste, delete, open 

a file or folder, and more. 
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16) Remote: 

 

It is a hardware device designed to control the functioning of a device, e.g., a TV remote 

that can be used to change channels, increase or decrease the volume, from a distance 

without leaving the seat. The first cordless TV remote was invented by Dr. Robert Adler 

of Zenith in 1956. The remote sends the electromagnetic waves to communicate with the 

device. These waves can be infrared rays, radio waves, etc. 

17) Touch screen: 

It is the display screen of a device such as a smartphone, tablet, etc., that allows users to 

interact or provide inputs to the device by using their finger. Today, most of the 

electronic devices come with touchscreen as an alternative to a mouse for navigating a 

graphical user interface. For example, by touching, you can unlock your phone, open 

emails, open files, play videos, etc. Besides this, it is used in lots of devices such as 

Camera, Car GPS, Fitness machine, etc. 

The concept of the touch screen was first introduced and published by E.A. Johnson in 

1965. The first touch screen was developed at the beginning of the 1970s by CERN 

engineers Frank Beck and Bent Stumpe. 

 

https://www.javatpoint.com/hardware
https://www.javatpoint.com/gps-full-form
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18) VR: 

 

VR stands for virtual reality. It is an artificial or virtual environment which is generated 

by computers. A person can interact with virtual objects of this artificial environment 

using some input devices such as headsets, gloves, headphones, etc. For example, he or 

she can find himself or herself walking on a beach, watching a football match, walking 

in the sky, etc., without actually doing all this. 

19) Webcam: 

 

Any camera which is connected to a computer is called a webcam. The in-built camera 

provided on a computer can also be considered a webcam. It is an input device as it can 

take pictures, and can be used to record videos if required. The pictures and videos are 

stored in the computer memory and can be displayed on the screen if required. Although 

it works almost the same as the digital camera, it is different from a digital camera, as it 

is designed to take compact digital photos that can be uploaded easily on the webpages 

and shared with others through the internet. 

20) Biometric Devices: 

Biometrics refers to a process in which a person is identified through his or her 

biological features such as fingerprints, eye cornea, face structure, etc. It is done by 

using biometric devices, which can be of different types based on their scanning features 

and abilities, such as: 

i) Face Scanner: 

https://www.javatpoint.com/computer-memory
https://www.javatpoint.com/biometrics-tutorial
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It is designed to identify a person by scanning his or her face. It takes the face 

measurements of a person. For example, the distance between eyes, nose, and mouth, 

etc., accordingly, it confirms the identity of a person. Besides this, it is smart enough to 

differentiate between a person's picture and the real person. 

ii) Hand Scanner: The hand of a person can also be used to verify his or her identity as 

every person has a unique pattern of veins in the palm, just like fingerprints. This device 

takes advantage of this feature; it identifies a person by scanning the palm of his hand. It 

uses infrared light to scan veins' patterns and blood flowing in them. Palm is even more 

unique than fingerprints. 

 

 

iii) Fingerprint Scanner: 
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It scans the fingerprints to identify people or for biometric authentication. This device is 

developed, keeping in mind the fact that no two persons in the world can have the same 

fingerprints. It is widely used in companies as a fingerprint attendance system to mark 

the attendance of employees. This type of scanners captures the pattern of valleys and 

ridges found on a finger and store it in the memory or database. When you press your 

finger on the given space, it verifies the identity by using its pattern-matching software. 

iv) Retina or Iris Scanner:  

It scans the retina or iris of a person's eye to confirm the identity. This device is more 

secure than others as it is next to impossible to copy the retina or iris. It works by 

mapping the retina's blood vessel patterns of the eye. The blood vessels of retina absorb 

light more easily as well as can be identified with appropriate lighting. 

In this scan, a beam of low-energy infrared light falls on the retina through the scanner's 

eyepiece. Then, the software captures the network of blood vessels in the retina and uses 

it to verify a person's identity. 

 

v) Voice Scanner: 
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It records the voice of a person and digitizes it to create a distinctive voice print or 

template. The voiceprints are stored in the database, and are used to verify the voice of a 

person to confirm his or her identity. The person is required to speak in the normal or 

same voice that was used to create a voice template. It is not much reliable as it can be 

misused using a tape recording. 

Output Devices 

The output device displays the result of the processing of raw data that is entered in the 

computer through an input device. There are a number of output devices that display 

output in different ways such as text, images, hard copies, and audio or video. 

Some of the popular output devices are: 

1. Monitor 

o CRT Monitor 

o LCD Monitor 

o LED Monitor 

o Plasma Monitor 

2. Printer 

o Impact Printers 

A. Character Printers 

i. Dot Matrix printers 

ii. Daisy Wheel printers 

B. Line printers 

i. Drum printers 

ii. Chain printers 

o Non-impact printers 

A. Laser printers 

B. Inkjet printers 

3. Projector 

1) Monitor 

The monitor is the display unit or screen of the computer. It is the main output device 

that displays the processed data or information as text, images, audio or video. 

The types of monitors are given below. i) CRT Monitor 
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CRT monitors are based on the cathode ray tubes. They are like vacuum tubes which 

produce images in the form of video signals. Cathode rays tube produces a beam of 

electrons through electron guns that strike on the inner phosphorescent surface of the 

screen to produce images on the screen. The monitor contains millions of phosphorus 

dots of red, green and blue color. These dots start to glow when struck by electron beams 

and this phenomenon is called cathodoluminescence. 

The main components of a CRT monitor include the electron gun assembly, deflection 

plate assembly, fluorescent screen, glass envelope, and base.The front (outer surface) of 

the screen onto which images are produced is called the face plate. It is made up of fiber 

optics. 

There are three electron beams that strike the screen: red, green, and blue. So, the colors 

which you see on the screen are the blends of red, blue and green lights.The magnetic 

field guides the beams of electrons. Although LCDs have replaced the CRT monitors, 

the CRT monitors are still used by graphics professionals because of their color quality. 

ii) LCD Monitor 

 

The LCD monitor is a flat panel screen that is compact and light-weight as compared to 

CRT monitors. It is based on liquid crystal display technology which is used in the 

screens of laptops, tablets, smart phones, etc. An LCD screen comprises two layers of 

polarized glass with a liquid crystal solution between them. When the light passes 

through the first layer, an electric current aligns the liquids crystals. The aligned liquid 
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crystals allow a varying level of light to pass through the second layer to create images 

on the screen. 

The LCD screen has a matrix of pixels that display the image on the screen.Old LCDs 

had passive-matrix screens in which individual pixels are controlled by sending a 

charge. A few electrical charges could be sent each second that made screens appear 

blurry when the images moved quickly on the screen. 

Modern LCDs use active-matrix technology and contain thin film transistors (TFTs) 

with capacitors. This technology allows pixels to retain their charge. So, they don?t 

make screen blurry when images move fast on the screen as well as are more efficient 

than passive-matrix displays. 

iii) LED monitor 

 

The LED monitor is an improved version of an LCD monitor. It also has a flat panel 

display and uses liquid crystal display technology like the LCD monitors. The difference 

between them lies in the source of light to backlight the display. The LED monitor has 

many LED panels, and each panel has several LEDsto backlight the display, whereas the 

LCD monitors use cold cathode fluorescent light to backlight the display.Modern 

electronic devices such as mobile phones, LED TVs, laptop and computer screens, etc., 

use a LED display as it not only produces more brilliance and greater light intensity but 

also consumes less power. 
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iv) Plasma Monitor 

 

The plasma monitor is also a flat panel display that is based on plasma display 

technology. It has small tiny cells between two glass panels. These cells contain 

mixtures of noble gases and a small amount of mercury. When voltage is applied, the 

gas in the cells turns into a plasma and emits ultraviolet light that creates images on the 

screen, i.e., the screen is illuminated by a tiny bit of plasma, a charged gas. Plasma 

displays are brighter than liquid crystal displays (LCD) and also offer a wide viewing 

angle than an LCD. 

Plasma monitors provide high resolutions of up to 1920 X 1080, excellent contrast 

ratios, wide viewing angle, a high refresh rate and more. Thus, they offer a unique 

viewing experience while watching action movies, sports games, and more. 

2) Printer 

A printer produces hard copies of the processed data. It enables the user, to print images, 

text or any other information onto the paper. 

Based on the printing mechanism, the printers are of two types: Impact Printers and 

Non-impact Printers. 

o Impact Printers: They are of two types: 

A. Character Printers 

i. Dot Matrix printers 

ii. Daisy Wheel printers 

B. Line printers 

i. Drum printers 

ii. Chain printers 

o Non-impact printers: They are of two types: 

A. Laser printers 

B. Inkjet printers 
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Impact Printer 

The impact printer uses a hammer or print head to print the character or images onto the 

paper. The hammer or print head strikes or presses an ink ribbon against the paper to 

print characters and images. 

Impact printers are further divided into two types. 

A. Character Printers 

B. Line printers 

A) Character Printers 

Character printer prints a single character at a time or with a single stroke of the print 

head or hammer. It does not print one line at a time. Dot Matrix printer and Daisy Wheel 

printer are character printers. Today, these printers are not in much use due to their low 

speed and because only the text can be printed. The character printers are of two types, 

which are as follows: 

i) Dot Matrix Printer 

 

Dot Matrix Printer is an impact printer. The characters and images printed by it are the 

patterns of dots. These patterns are produced by striking the ink soaked ribbon against 

the paper with a print head. The print head contains pins that produce a pattern of dots 

on the paper to form the individual characters. The print head of a 24 pin dot matrix 

contains more pins than a 9 pin dot matrix printer, so it produces more dots which results 

in better printing of characters. To produce color output, the black ribbon can be 

changed with color stripes. The speed of Dot Matrix printers is around 200-500 

characters per second. 
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ii) Daisy Wheel Printer 

 

Daisy Wheel Printer was invented by David S. Lee at Diablo Data Systems.It consists of 

a wheel or disk that has spokes or extensions and looks like a daisy, so it is named Daisy 

Wheel printer. At the end of extensions, molded metal characters are mounted. To print 

a character the printer rotates the wheel, and when the desired character is on the print 

location the hammer hits disk and the extension hits the ink ribbon against the paper to 

create the impression. It cannot be used to print graphics and is often noisy and slow, 

i.e., the speed is very low around 25-50 characters per second. Due to these 

drawbacks,these printers have become obsolete. 

B) Line Printers: 

Line printer, which is also as a bar printer, prints one line at a time. It is a high-speed 

impact printer as it can print 500 to 3000 lines per minute. Drum printer and chain 

printer are examples of line printers. 
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i) Drum Printer: 

 

Drum printer is a line printer that is made of a rotating drum to print characters. The 

drum has circular bands of characters on its surface. It has a separate hammer for each 

band of characters. When you print, the drum rotates, and when the desired character 

comes under the hammer, the hammer strikes the ink ribbon against the paper to print 

characters. The drum rotates at a very high speed and characters are printed by activating 

the appropriate hammers. Although all the characters are not printed at a time, they are 

printed at a very high speed. Furthermore, it can print only a predefined style as it has a 

specific set of characters. These printers are known to be very noisy due to the use of 

hammering techniques. 
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ii) Chain Printer: 

 

Chain printer is a line printer that uses a rotating chain to print characters. The characters 

are embossed on the surface of the chain. The chain rotates horizontally around a set of 

hammers, for each print location one hammer is provided, i.e., the total number of 

hammers is equal to the total number of print positions. 

The chain rotates at a very high speed and when the desired character comes at the print 

location, the corresponding hammer strikes the page against the ribbon and character on 

the chain.They can type 500 to 3000 lines per minute. They are also noisy due to the 

hammering action. 

Non-Impact Printer: 

Non-impact printers don't print characters or images by striking a print head or hammer 

on the ink ribbon placed against the paper. They print characters and images without 

direct physical contact between the paper and the printing machinery. These printers can 

print a complete page at a time, so they are also known as page printers. The common 

types of non-impact printers are Laser printer and Inkjet printer: 
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i) Laser Printer: 

 

A laser printer is a non-impact printer that uses a laser beam to print the characters. The 

laser beam hits the drum, which is a photoreceptor and draws the image on the drum by 

altering electrical charges on the drum. The drum then rolls in toner, and the charged 

image on the drum picks the toner. The toner is then printed on the paper using heat and 

pressure. Once the document is printed, the drum loses the electric charge,and the 

remaining toner is collected. The laser printers use powdered toner for printing instead 

of liquid ink and produce quality print objects with a resolution of 600 dots per inch 

(dpi) or more. 

ii) Inkjet Printer: 

 

The inkjet printer is a non-impact printer that prints images and characters by spraying 

fine,ionized drops of ink. The print head has tiny nozzles to spray the ink. The printer 

head moves back and forth and sprays ionized drops of ink on the paper, which is fed 

through the printer. These drops pass through an electric field that guides the ink onto 

the paper to print correct images and characters. 

An inkjet printer has cartridges that contain ink. Modern inkjet printers are color printers 

that have four cartridges containing different colors: Cyan, Magenta, Yellow, and Black. 

It is capable of printing high-quality images with different colors. It can produce print 

objects with a resolution of at least 300 dots per inch (dpi). 
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3) Projector 

 

A projector is an output device that enables the user to project the output onto a large 

surface such as a big screen or wall. It can be connected to a computer and similar 

devices to project their output onto a screen. It uses light and lenses to produce 

magnified texts, images, and videos. So, it is an ideal output device to give presentations 

or to teach a large number of people. 

Modern projects (digital projectors) come with multiple input sources such as HDMI 

ports for newer equipment and VGA ports that support older devices. Some projectors 

are designed to support Wi-Fi and Bluetooth as well. They can be fixed onto the ceiling, 

placed on a stand, and more and are frequently used for classroom teaching, giving 

presentations, home cinemas, etc. 

 

A digital projector can be of two types: 

Liquid Crystal Display (LCD) digital projector: This type of digital projectors are 

very popular as they are lightweight and provide crisp output. An LCD projector uses 

transmissive technology to produce output. It allows the light source, which is a standard 

lamp, to pass through the three colored liquid crystal light panels. Some colors pass 

through the panels and some are blocked by the panels and thus images are on the 

screen. 

Digital Light Processing (DLP) digital projector: It has a set of tiny mirrors, a 

separate mirror for each pixel of the image and thus provide high-quality images. These 

projectors are mostly used in theatres as they fulfill the requirement of high-quality 

video output. 

INTRODUCTION TO OPERATING SYSTEMS 

As the name suggests, an operating system is a type of software without which you 

cannot operate or run a computer. It acts as an intermediary or translation system 

between computer hardware and application programs installed on the computer. In 

other words, you cannot directly use computer programs with computer hardware 

without having a medium to establish a connection between them. 

Besides this, it is also an intermediary between the computer user and the computer 

hardware as it provides a standard user interface that you see on your computer screen 

after you switch on your computer. For example, the Windows and the Mac OS are also 

operating systems that provide a graphical interface with icons and pictures to enable 

users to access multiple files and applications simultaneously. 

https://www.javatpoint.com/hardware
https://www.javatpoint.com/hardware
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So, although the operating system is itself a program or software, it allows users to run 

other programs or applications on the system. We can say that is works behind the 

scenes to run your computer. 

Major Functions of Operating System: 

o Memory management: It manages both the primary and secondary memory 

such as RAM, ROM, hard disk, pen drive, etc. It checks and decides the 

allocations and deallocation of memory space to different processes. When a user 

interacts with a system, the CPU is supposed to read or write operations, in this 

case, OS decides the amount of memory to be allocated for loading the program 

instructions and data into RAM. After this program is terminated, the memory 

area is again free and is ready to be allocated to other programs by the OS. 

o Processor Management: It facilitates processor management, where it decides 

the order for the processes to access the processor as well as decides the 

processing time to be allocated for each process. Besides this, it monitors the 

status of processes, frees the processor when a process is executed then allocates 

it to a new process. 

o Device/ hardware management: The operating system also contains drivers to 

manage devices. A driver is a type of translation software that allows the 

operating system to communicate with devices, and there are different drivers for 

different devices as each device speaks a different language. 

o Run software applications: It offers the environment to run or use software 

applications developed to perform specific tasks, for example, Ms Word, Ms 

Excel, Photoshop, etc. 

o Data management: It helps in data management by offering and displaying 

directories for data management. You can view and manipulate files, folders, 

e.g., you can move, copy, name, or rename, delete a file or a folder. 

o Evaluates the system's health: It gives us an idea about the performance of the 

hardware of the system. For example, you can see how busy the CPU is, how fast 

the data is retrieved from the hard disk, etc. 

o Provides user interface: It acts as an interface between the user and the 

hardware. It can be a GUI where you can see and click elements on the screen to 

perform various tasks. It enables you to communicate with the computer even 

without knowing the computer's language. 

o I/O management: It manages the input output devices and makes the I/O 

process smooth and effective. For example, it receives the input provided by the 

user through an input device and stores it in the main memory. Then it directs the 

CPU to process this input and accordingly provides the output through an output 

device such as a monitor. 

o Security: It has a security module to protect the data or information stored in the 

memories of the computer against malware and unauthorized access. Thus, it not 

only manages your data but also helps to protect it. 

o Time Management: It helps CPU in time management. The Kernel OS keeps 

checking the frequency of processes that requests CPU time. When two or more 

processes that are equally important compete for the CPU time, then the CPU 

time is sliced into segments and allocated to these processes in a round-robin 

fashion to prevent a single process from monopolizing the CPU. 
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o Deadlock Prevention: Sometimes a resource that is supposed to be shared by 

two or more processes is held by one process due to which the resource cannot 

continue. This situation is known as deadlock. The OS does not let this situation 

arise by carefully distributing the resources among the different processes. 

o Interrupt Handling: OS also responds to interrupts, which are signals generated 

by a program or a device to seek the attention of the CPU. The OS checks the 

priority of the interrupt, and if it is more important than the currently running 

process, it stops the execution of the current process and preserves this state of 

CPU then executes the requested process. Thereafter the CPU returns to the same 

state where it was stopped. 

DOS 

Stands for "Disk Operating System." DOS was the first operating system used by IBM-

compatible computers. It was originally available in two versions that were essentially 

the same, but marketed under two different names. "PC-DOS" was the version 

developed by IBM and sold to the first IBM-compatible manufacturers. "MS-DOS" was 

the version that Microsoft bought the rights to, and was bundled with the first versions of 

Windows. 

DOS uses a command line, or text-based interface, that allows the user to type 

commands. By typing simple instructions such as pwd (print working directory) 

and cd (change directory), the user can browse the files on the hard drive, open files, and 

run programs. While the commands are simple to type, the user must know the basic 

commands in order to use DOS effectively (similar to UNIX). This made the operating 

system difficult for novices to use, which is why Microsoft later bundled the graphic-

based Windows operating system with DOS. 

The first versions of Windows (through Windows 95) actually ran on top of the DOS 

operating system. This is why so many DOS-related files (such as .INI, .DLL, 

and .COM files) are still used by Windows. However, the Windows operating system 

was rewritten for Windows NT (New Technology), which enabled Windows to run on 

its own, without using DOS. Later versions of Windows, such as Windows 2000, XP, 

and Vista, also do not require DOS. 

DOS is still included with Windows, but is run from the Windows operating system 

instead of the other way around. The DOS command prompt can be opened in Windows 

by selecting "Run..." from the Start Menu and typing 

WINDOWS OPERATING SYSTEM  

Microsoft Windows is one of the most popular Graphical User Interface (GUI). Multiple 

applications can execute simultaneously in Windows, and this is known 

as “Multitasking”. 

 

Windows Operating System uses both Keyboard and mouse as input devices. Mouse is 

used to interact with Windows by clicking its icons. Keyboard is used to enter alphabets, 

numerals and special characters. 

  

Some of the functions of Windows Operating System are: 

  

 Access applications (programs) on the computer (word processing, games, 

spread sheets, calculators and so on). 

 

 Load any new program on the computer. 
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 Manage hardware such as printers, scanners, mouse, digital cameras etc., 

 

 File management activities (For example creating, modifying, saving, deleting 

files and folders). 

 

 Change computer settings such as colour scheme, screen savers of your monitor, 

etc. 

 

INTRODUCTION TO PROGRAMMING LANGUAGES: C  

C is a general-purpose high level language that was originally developed by Dennis 

Ritchie for the Unix operating system. It was first implemented on the Digital 

Eqquipment Corporation PDP-11 computer in 1972. 

The Unix operating system and virtually all Unix applications are written in the C 

language. C has now become a widely used professional language for various reasons. 

 Easy to learn 

 Structured language 

 It produces efficient programs. 

 It can handle low-level activities. 

 It can be compiled on a variety of computers. 

Facts about C 

 C was invented to write an operating system called UNIX. 

 C is a successor of B language which was introduced around 1970 

 The language was formalized in 1988 by the American National Standard 

Institue (ANSI). 

 By 1973 UNIX OS almost totally written in C. 

 Today C is the most widely used System Programming Language. 

 Most of the state of the art software have been implemented using C 

Features of C Programming Language: 

1. Procedural Language 

2. Fast and Efficient 

3. Modularity 

4. Statically Type 

5. General Purpose Language 

6. Rich set of built in Operators 

7. Libraries with rich Functions 

8. Middle Level Language 

9. Portability 

10. Easy to Extend 

1. Procedural Language: In a procedural language like C step by step predefined 

instructions are carried out. C program may contain more than one function to 

perform a particular task. New people to programming will think that this is the 

only way of a particular programming language works. There are other 

programming paradigms as well in the programming world. Most of the commonly 

used paradigm is an object-oriented programming language. 
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2. Fast and Efficient: Newer languages like java, python offer more features than c 

programming language but due to additional processing in these languages, their 

performance rate gets down effectively. C programming language as the been 

middle-level language provides programmers access to direct manipulation with 

the computer hardware but higher-level languages do not allow this. That’s one of 

the reasons C language is considered as the first choice to start learning 

programming languages. It’s fast because statically typed languages are faster than 

dynamically typed languages. 

3. Modularity: The concept of storing of C programming language code in the form 

of libraries for further future uses is known as modularity. This programming 

language van does a very little on its own most of its power is held by its libraries. 

C language has it’s own library to solve common problems like in this we can use a 

particular function by using a header file stored in its library. 

4. Statically Type: C programming language is a statically typed language. Meaning 

the type of variable is checked at the time of compilation but not at run time. 

Means each time a programmer type a program they have to mention the type of 

variables used. 

5. General Purpose Language: From system programming to photo editing 

software, C programming language is used in various applications. Some of the 

common applications where it’s used are as follows: 

 Operating systems: Windows, Linux, iOS, Android, OXS 

 Databases: PostgreSQL, Oracle, MySQL, MS SQL Server etc. 

6. Rich set of built-in Operators: It is a diversified language with a rich set of built-

in operators which are used in writing complex or simplified C programs. 

7. Libraries with rich Functions: Robust libraries and functions in C help even a 

beginner coder to code with ease. 

8. Middle-Level Language: As it is a middle-level language so it has the combined 

form of both capabilities of assembly language and features of the high level 

language. 

9. Portability: C language is lavishly portable as programs which are written in C 

language can run and compile on any system with either none or small changes. 

10. Easy to Extend: Programs written in C language can be extended means when a 

program is already written in it then some more features and operations can be 

added into it. 

 

INTRODUCTION TO C++ PROGRAMMING LANGUAGE 

 Difficulty Level : Easy 

 Last Updated : 17 Feb, 2021 

 C++ is a general-purpose programming language that was developed as an 

enhancement of the C language to include object-oriented paradigm. It is an 

imperative and a compiled language.  

 C++ is a middle-level language rendering it the advantage of programming 

low-level (drivers, kernels) and even higher-level applications (games, GUI, 

desktop apps etc.). The basic syntax and code structure of both C and C++ are 

the same.  

Some of the features & key-points to note about the programming language are as 

follows: 

 Simple: It is a simple language in the sense that programs can be broken down into 

logical units and parts, has a rich libray support and a variety of data-types. 

 Machine Independent but Platform Dependent: A C++ executable is not 

platform-independent (compiled programs on Linux won’t run on Windows), 

however they are machine independent. 

https://www.geeksforgeeks.org/dbms/
https://www.geeksforgeeks.org/sql-tutorial/
https://www.geeksforgeeks.org/operators-c-c/
https://www.geeksforgeeks.org/functions-in-c/
https://www.geeksforgeeks.org/difference-between-high-level-and-low-level-languages/
https://www.geeksforgeeks.org/difference-between-high-level-and-low-level-languages/
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 Mid-level language: It is a mid-level language as we can do both systems-

programming (drivers, kernels, networking etc.) and build large-scale user 

applications (Media Players, Photoshop, Game Engines etc.) 

 Rich library support: Has a rich library support (Both standard ~ built-in data 

structures, algorithms etc.) as well 3rd party libraries (e.g. Boost libraries) for fast 

and rapid development. 

 Speed of execution: C++ programs excel in execution speed. Since, it is a 

compiled language, and also hugely procedural. Newer languages have extra in-

built default features such as grabage-collection, dynamic typing etc. which slow 

the execution of the program overall. Since there is no additional processing 

overhead like this in C++, it is blazing fast. 

 Pointer and direct Memory-Access: C++ provides pointer support which aids 

users to directly manipulate storage address. This helps in doing low-level 

programming (where one might need to have explicit control on the storage of 

variables). 

 Object-Oriented: One of the strongest points of the language which sets it apart 

from C. Object-Oriented support helps C++ to make maintainable and extensible 

programs. i.e. Large-scale applications can be built. Procedural code becomes 

difficult to maintain as code-size grows. 

 Compiled Language: C++ is a compiled language, contributing to its speed. 

 

Applications of C++:  

C++ finds varied usage in applications such as: 

 Operating Systems & Systems Programming. e.g. Linux-based OS (Ubuntu etc.) 

 Browsers (Chrome & Firefox) 

 Graphics & Game engines (Photoshop, Blender, Unreal-Engine) 

 Database Engines (MySQL, MongoDB, Redis etc.) 

 Cloud/Distributed Systems 

Some interesting facts about C++:  

Here are some awesome facts about C++ that may interest you: 

1. The name of C++ signifies the evolutionary nature of the changes from C. “++” is 

the C increment operator. 

2. C++ is one of the predominant languages for the development of all kind of 

technical and commercial software. 

3. C++ introduces Object-Oriented Programming, not present in C. Like other things, 

C++ supports the four primary features of OOP: encapsulation, polymorphism, 

abstraction, and inheritance. 

4. C++ got the OOP features from Simula67 Programming language. 

5. A function is a minimum requirement for a C++ program to run.(at least main() 

function) 

 

 

UNIT II 
 

WORD PROCESSING: OPEN, SAVE AND CLOSE WORD DOCUMENT 

While you are creating a document, it is often important to save it for future use. 

The saved document now becomes a file. A file is a complete, named collection of 

information, such as a user-created document. It is the basic unit of storage that enables 

a computer to distinguish one set of information from another. It is a collection of data 

that a user can retrieve, change, delete, save, or send to an output device, such as a 

printer or e-mail program. 

 

https://www.geeksforgeeks.org/interesting-facts-about-c/
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From the foregoing explanation, you realize that a saved document can be retrieved, 

viewed and reused. Here are the steps involved in opening/retrieving a saved 

document/file in Word environment. 

1. On the Menu bar, click File, and then click Open. The Open dialog box appears. 

2. In the Look in list, click the drive or folder that contains the file you want to 

open. 

3. Click the file. 

4. You'll see a preview of the selected file in the Preview box. 

5. Click Open. 

 

Open a File as Copy in Microsoft Word 

This feature allows you to open a copy of a document which you can edit and save, 

without such changes altering the content of the original file. When you open a file as a 

copy, a duplicate of the file is created in the older that contains the original file. You can, 

however, save the copy you opened in a different location (drive and folder) and with a 

different filename, using the Save As command in the File menu. 

 

Use this method if you want to work on a file of which you do not want the new changes 

to reflect on the original document. 

 

Steps: 

1. On the Menu bar, click File and then click Open. The Open dialog box appears. 

2. In the Look in list, double-click the drive or folder that contains the file you want 

to open. 

3. Select the file whose copy you want to open. 

4. Click the drop-down arrow next to the Open button to display a drop down list. 

5. From the drop-down list, click Open as Copy.  

Save a Document in Microsoft Word 
As you create a document, you will need to store it for future reference or use. 

In Word, you to save your documents in various ways. You can save all open 

documents at the same time. You can also save a copy of the active document with a 

different name or in a different location. If you share documents with people who use 

previous versions of Word, and you want to be sure the documents look the same when 

they're opened in the earlier versions, you can turn off features that are not part of that 

version. 

 

To save a document: 

1. Open the File menu and click Save. The Save As dialog box appears. 

2. In the File name box, enter a desired name for the document. 

3. To save the document in a folder or a drive other than the default, click the drop-

down arrow in the Save in box, and then choose the desired folder or drive. 

4. To save the document in a new folder within the current drive, click the Create 

New Folder button on the toolbar within the Save As dialog box, directly below 

the title bar of the Save As dialog box. 

5. Click Save.  
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Save a File/Document to another Format in Word 

You can save a Word document in a format that makes it possible to access or 

edit in other/earlier versions of Word or in other word processors such as WordPerfect. 

When you save your work in Word, it is stored in the default document format of the 

particular version of Word you are using. The file name of the saved document is 

automatically followed by a .doc extension. To be able to share documents with people 

who use other word processors or who use versions of Word that have a different file 

format, you will have to save documents in file formats that such word processors or 

other versions of Word can understand/read. For example, you can open a document 

created in WordPerfect, make changes to it in Word. 

 

Steps to save a file to another format in Microsoft Word: 

1. On the File menu, click Save As. 

2. In the File name box, enter a new name for the file. 

3. Click the Save as type list, and then click the file format that you want the file 

saved in. 

4. Click Save. 

Close a Document 

When you are through working in a document, you need to close it. This will help 

prevent unintended changes from being made to it, and also to free the computer 

working memory [Random Access Memory (RAM)] some space. 

 

Note, however, that closing a document means simply closing the active 

document (using the Close command or alternatives), without actually quitting the 

entire Word window.  

 

There are several ways of closing a document in Word. These methods use: 

 The File menu 

 The Close Window button on the menu bar 

 Shortcut keys 

Closing a Document Using the File Menu 

1. From the Menu bar, choose File. 

2. From the File menu, click Close. 

Close a Document Using the Close Window Button on the Menu Bar 
 

Simply click the Close Window (X) button to the extreme right of the Menu bar. The 

active document will be closed, leaving the Word program still running. Word or 

the Office Assistant will prompt you to save  your document, if you have unsaved 

changes in the document. 

 

Close a Document Using Shortcut Keys 

To close the current document without exiting Word, you can use any of the following 

shortcut keys, if you are a keyboard fan: 

 

 Press Ctrl and F4 keys simultaneously on the keyboard (Ctrl + F4). 

                                                       OR  

 Press Ctrl and W keys simultaneously on the keyboard (Ctrl + W). 
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TYPING AND EDITING TEXT 

1. Start typing your text. 

2. To start a new paragraph, press Enter. 

3. To add extra space between paragraphs, press Enter twice. 

4. To move the cursor in a document, click where you want to insert it or use the 

keyboard arrow keys to move it. 

5. To edit text, click in the word you want to change. 

 

HOW TO CREATE A BULLET LIST IN MICROSOFT WORD 

1. Position the cursor where you want to insert the bullet list. 

2. On the Home tab in the Ribbon, click the bullet list button, as shown at the top of 

the page. 

3. If successful, a bullet should appear. Type any text and press Enter to start the next 

bullet. To end the bullet list, press Enter twice. 

Below is an example of a bullet list. 

 One bullet 

 Two bullet 

HOW TO CREATE A NUMBERED LIST IN MICROSOFT WORD 

To create a numbered list in Microsoft Word, follow the steps below. 

1. Position the cursor where you want to insert the number list. 

2. On the Home tab in the Ribbon, click the number list button, as shown at the top 

of the page. 

3. If successful, a number one should appear. Type any text and press Enter to start 

the next number in the numbered list. To end the numbered list, press Enter twice. 

HOW TO CREATE A NUMBERED LIST WITH LETTERS 

To create a numbered list that also contains a letter list in Microsoft Word, follow the 

steps below. 

1. Position the cursor where you want to insert the number list. 

2. On the Home tab in the Ribbon, click the down arrow next to the number list 

button. 

 

3. In drop-down window that appears, select one of the numbered list options with 

letters. 

4. Type the text for the first lettered bullet item. 

https://www.computerhope.com/jargon/c/cursor.htm
https://www.computerhope.com/jargon/r/ribbon.htm
https://www.computerhope.com/jargon/b/bullet.htm
https://www.computerhope.com/jargon/e/enterkey.htm
https://www.computerhope.com/jargon/e/enterkey.htm
https://www.computerhope.com/jargon/r/ribbon.htm
https://www.computerhope.com/jargon/e/enterkey.htm
https://www.computerhope.com/jargon/n/numberin.htm
https://www.computerhope.com/jargon/e/enterkey.htm
https://www.computerhope.com/jargon/c/cursor.htm
https://www.computerhope.com/jargon/r/ribbon.htm
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5. Press Enter to add additional lettered bullet items. 

Below is an example of a numbered list using letters instead of numbers. 

  A. First bullet using letter 

  B. Second bullet using letter 

  C. Third bullet using letter 

To create a numbered list that also contains a letter list in Microsoft Word, follow the 

steps below. 

1. Position the cursor where you want to add a bulleted item using a letter. 

2. Press Enter and then Tab. 

3. Press Enter again to add additional lettered bullet items. 

Below is an example of a numbered list with letters in it. 

1. One numbered 

2. Two numbered 

     a. Two numbered again 

     b. Two numbered again 

3. Final numbered 

DOCUMENT FORMATTING 

Document formatting refers to the way a document is laid out on the page—the way it 

looks and is visually organized—and it addresses things like font selection, font size and 

presentation (like bold or italics), spacing, margins, alignment, columns, indentation, and 

lists. Basically, the mechanics of how the words appear on the page. A well formatting 

document is consistent, correct (in terms of meeting any stated requirements), and easy 

to read. 

The visual appeal of a document has an effect on the reader and how they 

perceive the information, so it’s important in any piece of writing or documentation to 

be concerned with its formatting. Formatting also makes information more accessible to 

the reader by creating and labeling sections (headings), highlighting key words or ideas 

(bold, italics, or lists), and making a good impression (professional look and feel, 

appropriate font choice for the document type). 

There are many ways to format a technical or professional document. Assignments may 

specify formatting requirements, but if a style is not dictated, maintain a clear and 

consistent format throughout the document. 

https://www.computerhope.com/jargon/e/enterkey.htm
https://www.computerhope.com/jargon/c/cursor.htm
https://www.computerhope.com/jargon/e/enterkey.htm
https://www.computerhope.com/jargon/t/tab.htm
https://www.computerhope.com/jargon/e/enterkey.htm
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Especially when combining work from multiple team members, details like slight 

differences in font size or line spacing are easy to miss, but these subtle inconsistencies 

detract from the overall professionalism of your document. Sloppy formatting will 

reflect poorly on your abilities, and your audience may lose confidence in your message. 

Basic Formatting Standards for Lab Documents 

A few standards that should be used in most lab documents, unless specified otherwise: 

 11-12 pt. font in a consistent style throughout, including headers, footers, and visual 

labels 

 14 pt font for section headings (and “Memo” or other document label within a 

header) 

 A standard, professional font (e.g., Times New Roman, Cambria, Calibri) 

 Single or 0.15 line spacing, with no indentation on the first line of the paragraph 

 Additional line break between paragraphs 

 Left-justified body text 

 Page numbers at bottom right corner (starting the first page of the main text, i.e. not 

the cover page or Table of Contents) 

 1in. margins 

 PARAGRAPH ALIGNMENT 

 

There are four types of paragraph alignment you can set within Word: 

 Left-aligned. All lines in the paragraph butt up against the left text margin. No 

extra spaces are added to the line. The text of each line does not line up with the 

right margin, so traditional typesetting terminology often refers to left-aligned 

text as ragged right. 

 Center-aligned. All lines in a paragraph are centered between the left and right 

text margins. No extra spaces are added to the line. The text lines up with neither 

the left nor right margins. 

 Right-aligned. All lines in a paragraph butt up against the right text margin. No 

extra spaces are added to the line. The text of each line does not line up with the 

left margin, so traditional typesetting terminology often refers to right-aligned 

text as ragged left. 

 Justified. All lines in a paragraph are expanded so they butt up against both the 

left and right text margins. Space is added, between words and characters, as 

necessary to fill out the line. In some typesetting references justified text is also 

referred to as "full justified." 

There is also an undocumented alignment for paragraphs called "distributed text 

justification." This alignment is very similar to Justified alignment, except it also forces 

the last line of the paragraph—regardless of how short it is—to be stretched all the way 

to the right margin. You can only access this alignment type by placing the insertion 

point within the paragraph and pressing Ctrl+Shift+J. 
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INDENTATION 

 

indent or indentation is the increase or decrease of space between the left and 

right margin of a paragraph. To indent text, move the cursor to the front of the line and 

press the Tab on the keyboard. 

The shortcut key Ctrl+M or Ctrl+> (Ctrl and greater than) indents all highlighted text 

and Ctrl+Shift+M or Ctrl+< to decrease the indent of selected text in Word and other 

programs 

A typical indent is five spaces from the left or right side of the page. 

Text programs that support a tab also support multiple indents. For example, you could 

press Tab three times to indent a line fifteen spaces from the left side. 

 

HOW TO INSERT A HEADER AND FOOTER IN MICROSOFT WORD 

DOCUMENT? 

In Microsoft Word, Headers and Footers are used to insert additional information 

such as title, file name, date, page numbers, etc. The presence of both header and footer 

in the Word document makes your document more professional and easier to read as 

well as understand. 

Headers appear at the top margin of the Word document, while Footers appear at the 

bottom margin of the Word document 

To insert a header and footer in Microsoft Word, follow the below given basic steps - 

 

Step 1: Open the new or an existing Word document in which you want to insert header 

and footer. 

Step 2: Go to the Insert tab at the top of the Ribbon. 

Step 3: Click on either header or footer drop-down menu in the Header & Footer section. 

Step 4: A Header or Footer drop-down menu will display on the screen with a list of 

built-in Header or Footer options. Select your desired option from the Built-in list. 

Step 5: A Design tab with Header & Footer option will appear at the top of the document 

(on the Ribbon), as shown in the below screenshot. 

Step 6: Type your desired information into the header or footer section. 

Step 7: Once you type your desired text in the Header section, click on Close Header and 

Footer under the Design section on the Ribbon or press the Esc key from the keyboard to 

remove the dotted underline. Now, you can see that the Header is inserted to the Word 

document. 

 

CHECK SPELLING AND GRAMMAR 

 

On the Review tab, click Spelling & Grammar. If Word finds a potential error, the 

Spelling & Grammar dialog box will open, spelling errors will be shown as red text, and 

grammatical errors will be shown as green text. To fix an error, do one of the following: 

Type the correction in the box and then click Change. 

 

Run the spelling and grammar checker manually 

 

SPELLING AND GRAMMAR CHECKING 

 

Open most Office programs, click the Review tab on the ribbon. In Access or InfoPath 

you can skip this step. In Project you'll go to the Project tab. 

https://www.computerhope.com/jargon/m/margin.htm
https://www.computerhope.com/jargon/p/paragraph.htm
https://www.computerhope.com/jargon/c/cursor.htm
https://www.computerhope.com/jargon/t/tab.htm
https://www.computerhope.com/jargon/k/keyboard.htm
https://www.computerhope.com/jargon/c/ctrl-m.htm
https://www.computerhope.com/jargon/g/greathan.htm
https://www.computerhope.com/jargon/h/highligh.htm
https://www.computerhope.com/jargon/m/microsoft-word.htm
https://www.computerhope.com/jargon/s/spacebar.htm
https://www.computerhope.com/jargon/t/tab.htm
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1. Click Spelling or Spelling & Grammar. 

2. Spelling and grammar button on the Review ribbon 

3. If the program finds spelling mistakes, a dialog box appears with the first misspelled 

word found by the spelling checker. 

4. After you decide how to resolve the misspelling (ignoring it, adding it to the 

program’s dictionary, or changing it), the program moves to the next misspelled word. 

 

FIND AND REPLACE 

 

Go to Home > Replace or press Ctrl+H. Enter the word or phrase you want to locate in 

the Find box. Enter your new text in the Replace box. 

 

Introduction  

While working on editing a document you come across a situation very frequently when 

you want to search a particular word in your document and many times you will be 

willing to replace this word with another word at a few or all the places throughout the 

document 

 

Find Command 

The Find command enables you to locate specific text in your document. Following are 

the steps to find a word document in the following screen − 

 

Find & Replace Operation 

We assume you are an expert in searching a word or phrase in a word document as 

explained above. This section will teach you how you can replace an existing word in 

your document. Following are the simple steps − 

 

Step 1 − Click the Replace option in the Editing group on the Home tab or press Ctrl + H 

to launch the Find and Replace dialog box shown in Step 2 − 

Step 2 − Type a word which you want to search. You can also replace the word using the 

Find and Replace dialog box as in the following screenshot − 

Step 3 − Click the Replace button available on the Find and Replace dialog box and you 

will see the first occurrence of the searched word would be replaced with the replace 

with word. Clicking again on Replace button would replace next occurrence of the 

searched word. If you will click Replace All button then it would replace all the found 

words in one go. You can also use Find Next button just to search the next occurence 

and later you can use Replace button to replace the found word. 

Step 4 − You can use More >> button available on the dialog box to use more options 

and to make your search more specific like case sensitive search or searching for whole 

word only etc. 

Step 5 − Finally, if you are done with the Find and Replace operation, you can click the 

Close (X) or Cancel button of the dialog box to close the box. 
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PRINT PREVIEW 

 

Print preview is a feature that displays on the screen what a hard copy would look like 

when printed. Using print preview, you can find any errors that may exist or fix the 

layout before printing, which can save ink or toner and paper by not having to print more 

than once. 

To open the print preview feature, click the print preview icon on the toolbar, like that 

shown in the picture, or click File and choose the Print Preview option. 

PRINTING LANGUAGE 

To print a document, your computer needs to be connected to a printer. Being 

able to print is not necessary in order to use Word, but if you want to send a letter in the 

post or print out a poster, you’ll need to have access to a printer. 

Step 1: Open an existing Microsoft Word document or start a new document, if you 

have Windows 10 you can use Cortana to search for it. Before you print, type your text 

in the blank document or insert an image.  

Step 2: When you are ready, click on File in the top left-hand corner of your document. 

Then, click on Print 

 

MAIL MERGE 

Mail merge consists of combining mail and letters and pre-

addressed envelopes or mailing labels for mass mailings from a form letter.[1] 

This feature is usually employed in a word processing document which contains 

fixed text (which is the same in each output document) and variables (which act as 

placeholders that are replaced by text from the data source word to word). 

Some word processors can insert content from a database, spreadsheet, or table into text 

documents.[2][3] 

It is a powerful tool for writing a personalized letter or e-mail to many people at the 

same time. It imports data from another source such as a spreadsheet and then uses that 

to replace placeholders throughout the message with the relevant information for each 

individual that is being messaged. 

 

How to Use Mail Merge in Microsoft Word 

 

1. In a blank Microsoft Word document, click on the Mailings tab, and in the 

Start Mail Merge group, click Start Mail Merge . 

2. Click Step-by-Step Mail Merge Wizard . 

3. Select your document type. ... 

4. Select the starting document. ... 

5. Select recipients. ... 

6. Write the letter and add custom fields. 

 

Explanation on Six Steps to Completing a Mail-Merge 

Mail merging means to plug data from an address table into  form  letters,  e-mail  
messages, envelopes, address labels, or a directory (a list or catalog, for example). 

 

https://www.computerhope.com/jargon/h/hardcopy.htm
https://www.computerhope.com/jargon/i/ink.htm
https://www.computerhope.com/jargon/t/toner.htm
https://www.computerhope.com/jargon/t/toolbar.htm
https://en.wikipedia.org/wiki/Letter_(message)
https://en.wikipedia.org/wiki/Envelope
https://en.wikipedia.org/wiki/Form_letter
https://en.wikipedia.org/wiki/Mail_merge#cite_note-1
https://en.wikipedia.org/wiki/Word_processor
https://en.wikipedia.org/wiki/Plain_text
https://en.wikipedia.org/wiki/Mail_merge#cite_note-2
https://en.wikipedia.org/wiki/Mail_merge#cite_note-2
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To start a mail merge, choose Tools | Letters  and  Mailings  |  Mail  Merge  Wizard  to 

open the Mail Merge task pane. 

 

Step 1: Select a Document Type 

The first step is to select what Word calls a “document  type”  in the  Mail  Merge  task 

pane, what kind of mail-merge you want to undertake: form letters, e-mail messages, 

envelopes  for  mass-mailings,  labels  for  mass-mailings,  or  a  directory  (a  list   or 

catalog). Choose an option button  and click  Next  at the bottom  of the task  pane  to go 

to step 2. 

 

Step 2: Select a Starting Document 

What Word calls the “starting document” is the document in which  the  merging  takes 

place.   In other words, the address or other data you retrieve will land in the document   

you choose or create now. 

 

You can create a new start document or use an existing one. In the case of labels and 

envelopes, you tell Word what size  labels  or envelopes  you  intend  to print  on.  In the 

case of  form letters, e-mail messages, and directories, you supply the  text  either  by 

making use of a document you’ve written already or writing a new document. 

Step 3: Select Recipients 

In step 3, you tell Word where to get the data that you will merge into the  starting  

document  you created or supplied  in step 2.  You can retrieve the data from a table in      
a Word document, an Access database  table  or  query,  or the address book or contact 

list where you store your addresses. You can also create a new list for the data if you 

haven’t entered the data in a file yet. 

Step 4: Write/Arrange Your Document 

In step 4, you insert the  merge  fields, the  parts of  the  starting  document  that  differ 

from recipient to recipient. By inserting merge fields, you tell Word where to plug 

information from  the  data  source  into  the  starting  document.  You  also  tell  Word  

which data to take from the data source. Word offers  special  tools  for  entering  an 

address block – the recipient’s address, including his or her name, company, title, 

street address, city, and zip code. 

Step 5: Preview Your Document 

In step 5, you get a chance to see what your form letters, e-mail messages, envelopes, 

labels, or directory will look  like  after  they  are  printed  or sent. In this step, you  find 

out what the document will look like when real data is plugged into it. 



 

 

If something is amiss  in  the  document,  you  can  click  the  Previous  link  to  return  to step 4, the 
Write/Arrange your document task pane, and make changes there. 

Step 6: Complete the Merge 

Step 6 is where you complete the  merge  by  either  printing  a new  document  or  saving the new file  

and  printing  it  later.  By  saving  the  merged  data  in  a  new  file,  you  can edit the file before 

printing it. In  the  case  of  e-mail  messages, you click the Electronic Mail link to tell Word to send 

the e-mail messages. 

 

QUESTION AND ANSWERS 

 

1. What is the use of Bullets and Numbering? 

In bulleted lists, each Item will begin with a bullet character. In numbered lists, each item 

begins with an expression that includes a number or letter and a separator such as a period or 

parenthesis. 

2. Write the Components of Microsoft Word – Title bar, Menu Bar, Tool Bar, document area, 

status bar, scroll bar 

3. Write a note on  

(i) Creating a document   (ii) Saving a document 

(iii) Opening a document  (iv) Closing a document 

(i) File🡪 New, to create new empty document 

(ii) [ Ctrl+S], File🡪Save, enter a name to save a file 

(iii)[ Ctrl+O], File🡪Open, To open an existing file 

(iv) [ Alt+F+C], File🡪Close, to close a file 

4. Various formatting facilities of MS Word. 

Move a text, Copy and paste a text, Select a text, Setting Font name, style and size, Highlighting 

text etc… 

5. Explain various operations performed on Worksheet. 

● Deleting a Column or a Row 

● Click on the column or row header to highlight the entire column or row to be deleted. Right-

click on any cell in the highlighted column or row. Click on Delete from the menu. 

● Inserting a Column 

● Click on the column header directly to the right of where you want to insert a new column. 

Right-click on any cell in the highlighted column. Click on Insert from the menu. 

● Inserting a Row 

● Click on the row header directly below where you want to insert a new row. Right-

click on any cell in the highlighted row. Click on Insert from the menu. 

● Sorting 

● Click on the grey rectangle between the "A" column header and the "1" row header in 

the upper left corner of the worksheet to select the entire worksheet. Click on Data on 

the menu bar, and then Sort... Under Sort by, select the column to sort by and select 

either Ascending or Descending order. 



 

 

6. What is the use of Microsoft Word? 

To prepare documents. It allows edit/delete/insert operations on text 

7. Write the Command to save the MS Word document – File 🡪Save (or) Ctrl+S 

8. Write the steps to create a Table in MS Word. 

Click on Table from the menu bar. Select Insert, and then Table  

⮚ Enter the desired number of rows and columns. 

⮚ Choose AutoFit behavior if you want the table's cells to automatically expand to fit the text 

inside them. ...  

⮚ Click OK to insert your table. 

9.  Write a note on  (i) Bullets and Numbering  (ii) Font 

● In bulleted lists, each paragraph begins with a bullet character. In numbered lists, each 

paragraph begins with an expression that includes a number or letter and a separator such as 

a period or parenthesis. The numbers in a numbered list are updated automatically when you 

add or remove paragraphs in the list. 

● Word comes with the default font face set to Calibri, a Microsoft specific font face. 

Changing the default to a more common font face, Arial for example, will ensure that your 

document displays properly for everyone who views it. 

10. Concept Text Formatting 

Formatted text is any text that contains special formatting such as font size, font color, bold, 

italic, etc. When copying text, formatted text is any text that keeps its settings from where it 

is copied. 

11.  How will you change font in Microsoft Word? 

Home tab 🡪 Font or [control + shift + F] 

12. List the features of MS Word.  

Editing / Updation, Document, Mail merge, Table and Chart Creation 

13. Write a note on Border and Shading from Microsoft Word. 

⮚ Select the text you need to apply borders or shading. 

⮚ Click Menus tab. 

⮚ Move to Format menu. 

⮚ Choose Borders and Shading in the drop down menu. 

 

 14. How will you perform Cut, Copy, Paste and Select a portion of text in word? 

Cut – Erase the text from original place, and paste it in required place [Ctrl+X] 

Copy – copy the text from original place, and paste it in required place [Ctrl+C] 

Paste –Paste text in required place [Ctrl+V] 

Select- Select all will select all the text of the document [Ctrl+A] 

 

15. What is the use of the function “Abs”? 

Used to find absolute value of a number 

 

16. Write the steps of Table Creation. Create a Table for your class Time table. 



 

 

Click on Table from the menu bar. Select Insert, and then Table… ...  

⮚ Enter the desired number of rows and columns. 

⮚ Choose AutoFit behavior if you want the table's cells to automatically expand to fit the text 

inside them. ...  

⮚ Click OK to insert your table. 

 

17. Write the steps to do the Mail Merge Concept.  

● In a blank Microsoft Word document, click on the Mailings tab, and in the Start Mail Merge 

group, click Start Mail Merge . 

● Click Step-by-Step Mail Merge Wizard . 

● Select your document type.  

● Select the starting document.  

● Select recipients. 

● Write the letter and add custom fields. 

● Press Enter on your keyboard and click Greeting line... to enter a greeting. 

● In the Insert Greeting Line dialog box, choose the greeting line format by clicking the drop-

down arrows and selecting the options of your choice, and then click OK. 

● Note that the address block and greeting line are surrounded by chevrons (« »). Write a short 

letter and click Next: Preview your letters. 

 

UNIT - IV 

SPREADSHEETS 

A spreadsheet is essentially a matrix of rows and columns. Consider a sheet of paper on which 

horizontal and vertical lines are drawn to yield a rectangular grid. The grid namely a cell, is the 

result of the intersection of a row with a column. Such a structure is called a Spreadsheet. 

 

A spreadsheet package contains electronic equivalent of a pen, an eraser and large sheet 

of paper with vertical and horizontal lines to give rows and columns. The cursor position 

uniquely shown in dark mode indicates where the pen is currently pointing. We can enter text or 

numbers at any position on the worksheet. We can enter a formula in a cell where we want to 

perform a calculation and results are to be displayed. A powerful recalculation facility jumps into 

action each time we update the cell contents with new data. 

MS-Excel is the most powerful spreadsheet package brought by 

Microsoft. The three main components of this package are 

 

 Electronic spreadsheet 

 Database management 

 Generation of Charts. 

 

Each workbook provides 3 worksheets with facility to increase the number of sheets. 

Each sheet provides 256 columns and 65536 rows to work with. Though the spreadsheet 

packages were originally designed for accountants, they have become popular with almost 

everyone working with figures. Sales executives, book-keepers, officers, students, research 

scholars, investors bankers etc, almost any one find some form of application for it.  



 

 

 

Excel definition: a software program created by Microsoft that uses spreadsheets to organize 

numbers and data with formulas and functions. Excel analysis is ubiquitous around the world 

and used by businesses of all sizes to perform financial analysis. 

Microsoft Excel is a spreadsheet program. That means it's used to create grids 

of text, numbers and formulas specifying calculations. That's extremely valuable for many 

businesses, which use it to record expenditures and income, plan budgets, chart data and 

succinctly present fiscal results. 

Features of Microsoft Excel 

 Add Header and Footer. MS Excel allows us to keep the header and footer in our  

spreadsheet document. 

 Find and Replace Command. ... 

 Password Protection. ... 

 Data Filtering. ... 

 Data Sorting. ... 

 Built-in formulae. ... 

 Create different charts (Pivot Table Report) ... 

 Automatically edits the result. 

CREATING TABLES 

1. Open the Excel spreadsheet. 

2. Use your mouse to select the cells that contain the information for the table. 

3. Click the "Insert" tab > Locate the "Tables" group. 

4. Click "Table". ... 

5. If you have column headings, check the box "My table has headers". 

6. Verify that the range is correct > Click [OK]. 

 

USING TABLES AND CREATING GRAPHS 

1. Enter your data into Excel. 

2. Choose one of nine graph and chart options to make. 



 

 

3. Highlight your data and 'Insert' your desired graph. 

4. Switch the data on each axis, if necessary. 

5. Adjust your data's layout and colors. 

6. Change the size of your chart's legend and axis labels. 

 

QUESTION AND ANSWERS FROM MICROSOFT EXCEL - SPREADSHEET 

1. What is the use of Excel Worksheet - Creating grids of text, numbers and formulas for 

calculations. That's extremely valuable for many businesses, which use it to record 

expenditures and income, plan budgets, chart data and succinctly present fiscal results 

 

2. How will you insert and delete a row and column in a worksheet? 

Insert a worksheet: click on the insert Worksheet icon [Ctrl+F11] 

Delete a Worksheet: click on respective worksheet icon & press Delete 

3. Explain any ten functions of MS Excel with example. 

● SUM - Find the SUM of sequence of numbers. ...  

● AVERAGE - Find the AVERAGE of sequence of numbers. ...  

● COUNT - COUNT of appearance  

● TRIM - Removes the spaces   

● MAX  - Find the maximum   

● MIN – Find the minimum 

● Abs – Find the absolute value of a number 

● Round – Round the fractional part to its next position 

● AND – To Apply and logic  

● OR – Apply or logic 

4. Define Cell – is an intersection of row and column. Cell address is referred by column 

name and row number. Ex. A1 

5. Explain the following operations performed on worksheet. 

(i)Insert (ii) Delete  (iii)Move (iv) Copy 

● Click on new worksheet icon which is available in status bar or [shift +F11] 

● Delete a Worksheet: click on respective worksheet icon & press Delete 

● Move – Erase the text from original place, and paste it in required place [Ctrl+X] 

& to Paste text in required place [Ctrl+V] 

● Copy – copy the text from original place, and paste it in required place [Ctrl+C] & 

to Paste text in required place [Ctrl+V] 

6.  List different Chart Types. Write the steps to create a chart.  

● The Pie Chart. A Pie Chart can only display one series of data. The Column Chart. 

The Column Chart very effectively shows the comparison of one or more series of 

data points. The Line Chart. The Bar Chart. The Area Chart. The Scatter Chart.  

STEPS  
o Select data for the chart. 

o Select Insert 🡪 Recommended Charts. 



 

 

o Select a chart on the Recommended Charts tab, to preview the chart. Note: 

You can select the data you want in the chart and press ALT + F1 to create a 

chart immediately, but it might not be the best chart for the data. ...  

o Select a chart. 

o Select OK. 

7. Write the steps to insert worksheet. 

Click on new worksheet icon which is available in status bar or [shift +F11] 

8. What is the use of the function “Round”? 

Used to round the decimal number to next position 

9. Explain the Features of MS Excel.  Add Header and Footer. MS Excel allows us to keep 

header and footer in our spreadsheet document. 

● Find and Replace Command. ...  Password Protection. ...  

● Data Filtering. ... Data Sorting. ... Built in formulae. ...  

● Create different charts (Pivot Table Report) ... Automatically edits the result. 

10. Explain various operations performed on MS Excel. 

⮚ Deleting a Column or a Row 

⮚ Click on the column or row header to highlight the entire column or row to be deleted. 

Right-click on any cell in the highlighted column or row. Click on Delete from the menu. 

⮚ Inserting a Column 

⮚ Click on the column header directly to the right of where you want to insert a new 

column. Right-click on any cell in the highlighted column. Click on Insert from the 

menu. 

⮚ Inserting a Row 

⮚ Click on the row header directly below where you want to insert a new row. Right-click 

on any cell in the highlighted row. Click on Insert from the menu. 

⮚ Sorting 

⮚ Click on the grey rectangle between the "A" column header and the "1" row header in the 

upper left corner of the worksheet to select the entire worksheet. Click on Data on the 

menu bar, and then Sort... Under Sort by, select the column to sort by and select either 

Ascending or Descending order. 

 

UNIT V 

MS-POWERPOINT 

PowerPoint (PPT) is a powerful, easy-to-use presentation graphics software program which 

allows you to create professional-looking electronic slide shows. PPT is used to present 

information in an organized manner to an individual or group. Using clip art, sound clips, movie 

clips, graphs, organization charts, imported Web screens, and many other features, you can easily 



 

 

create a presentation that will impress your audience and convey your message clearly and 

professionally Customize Color Schemes. 

 Add Animation effects. 

 Use the Slide, Notes and Handout Masters. 

 Create, Edit and Import Charts. 

 Create and Edit Tables. 

 Manage Hyperlinks. 

 Create Custom Shows. 

 Export Outlines & Presentation Slides to Word. 

 

CREATING SLIDES AND SLIDESHOW 

A slide is a single page of a presentation. Collectively, a group of slides may be known as 

a slide deck. ... In the digital age, a slide most commonly refers to a single page developed using 

a presentation program such as MS PowerPoint, Apple Keynote, Google Slides or Apache Open 

Office  

Select a design template 

1. In the PPT Start-up Window, click “From Design Template” located on the 

right-hand side of the screen under the heading “New.” 

2. Scroll down to see the various templates and click on one of them. 

(Slide 1, cont.) – Add title and subtitle 

1. Click once on “Click to add title” (this is the title placeholder) and type How to 

Use PowerPoint. 

2. Click once on “click to add subtitle” and type Building an Effective 

Presentation. 

(Slide 2) – Add a Bulleted List slide 

1. Click on the “New Slide” button at the toolbar located at the top of the screen. 

2. Click once on the title placeholder and type What you can do with 

PowerPoint. 

3. Click once on “Click to add text” (this is the text placeholder) and type the 

following text (hit <Enter> at the end of each line): 

 Create electronic presentations 

 Use special features to enhance your slides 

 Practice and time your slide show 

 



 

 

(NOTE: To format bullets, click on the “Format” menu and then click on “Bullets and 

Numbering.”) 

 

(Slide 3) – Add a Text & Content Layout Slide 

1. Click on the “New Slide” button. 

2. On the right side, scroll down until you see the “Text and Content Layout” 

options. 

3. Click once on the option of your choice. 

4. Type Content Options in the title placeholder. 

5. In the text placeholder, add the following text (hit <Enter> after each line): 

 Clip Art 

 Photographs 

 Charts 

 Graphs 

 Tables 

 Diagrams 

 Media Clips 

6. Click on the Clip Art icon in the “add content” area. 

7. Enter medicine in the search window. 

8. Scroll through the results and double-click on the Clip Art of your choice. 

 

(Hint: Type “photograph” in the Clip Art search window to see the clip art photo options) 

 

(Slide 4) – Add another Text & Content slide 

1. Click on the “New Slide” button. 

2. Type Advantages to Using a Variety of Content in the title placeholder. 

 In the text placeholder, type the following text (hit <Enter> at the end of each line): 

 Graphics keep a presentation lively 

 Graphics are effective teaching tools 

 Graphics keep the audience awake! 

3. Add the Clip Art of your choice to the slide 

 

(Slide 5) – Add a Chart 

1. Click on the “New Slide” button. 

2. Scroll down to “Other Layouts” and click on the “Title and Chart” option (the last 

option). 

3. Type Simple Charts in the title placeholder. 

4. Double-click on the chart placeholder. 

5. A datasheet will appear. Make changes if you like. 

6. Click once in your slide (outside the datasheet) to add the chart to your slide. 

 



 

 

Congratulations! You have completed a basic slide show. In the next lesson, we will 

enhance the presentation to make it more interesting. 

 

EXERCISE: Enhancing Your Slide Show 

 

Adding Transitions 

 

 Click on the “Slide Sorter View” button on the bottom, left-hand corner of your 

screen. 

 Click the “Slide Show” menu and then click on “Slide Transition.” 

 Click the “Edit” menu and click “Select All” 

 To the right, click a transition of your choice. This will apply to all the selected 

slides. (Note: Select “Random Transition” – the last option – to have a variety of 

transitions in your slide show) 

 

Animating Text 

 

 All slides should still be selected (if they aren’t, click the “Edit” menu and then “Select 

All”). 

 Click the “Slide Show” menu. 

 Click on “Animation Schemes.” 

 At the right, choose an Animation Scheme. You will see a preview within your slide sorter view. 

 

(Note: to apply a different Animation Scheme to each slide, you will have to select each slide 

individually and then choose a scheme for each one.) 

 

Please Note: For more advanced Animation options, you will need to utilize the “Custom 

Animation” options. These are covered in the Advanced PPT class. 

 

Running the Slide Show 

 

 Click once on the first slide to select it. 

 Click on the “Slide Show” button on the bottom left-hand corner of the screen. 

 To advance to the next slide, click the mouse once. 

 To draw on the slide, right-click, select “pointer options,” and “pen”. Hold down the 

mouse and write. Any marks you make are NOT permanent. Hit <Esc> to return to the 

pointer. 

 To go back one slide use the left arrow key. 

 To Exit the slide show quickly, hit <Esc>. 

 

Importing Web Screens 

 



 

 

 Start with a blank slide in Normal View. 

 Minimize the PPT program by clicking on the “minus” sign in the upper right 

corner. 

 Go into the Web and locate the screen you’d like to use in your presentation. 

 When the screen you want is displayed, hit the <Print Screen> key on your 

keyboard. This automatically saves the screen to the computer’s clipboard. 

 Minimize the web program (the minus button at the top right) and then maximize the 

PPT program (click on the Microsoft PowerPoint button at the bottom of your 

screen). 

Click on the Paste icon on the toolbar (looks like a clipboard). The screen you saved will now 

appear on your blank slide. 

 Click once on the image and then drag the corners to fill the screen. 

 

Note: You may want your slide to have a white background to better display the Web screen 

shot. To do this, click the “Format” menu, click “Background,” and select white from the 

pull-down menu of colors. You might also want to click “Omit background graphics.” Be 

sure to click “Apply” and NOT “Apply to All”! 

 

Inserting Pictures into Your Slides 

 

You can easily add pictures to your PPT slides. To do so, you must first save the picture to 

the hard drive of your computer. Then insert it into your presentation: 

 

 In Normal View, display the slide on which you’d like the picture to appear. 

 From the Insert menu, choose the Picture from File command. 

 Locate the file of the picture you have previously saved and double- click the file 

name. 

 The picture will now appear on your slide. 

 You may move and resize the picture as you like. 

 

WHAT IS SLIDE TRANSITION 

A slide transition is how one slide is removed from the screen and the next slide is displayed 

during a presentation. ... The transitions tab contains the Transitions to This Slide group. From 

this group choose a special effect to be applied during the transition between the 

previous slide to the next slide. Slide transitions are the animation-like effects that happen when 

you move from one slide to the next during a presentation. Add slide transitions to bring your 

PowerPoint presentation to life. 

Select the slide you want to add a transition to. 

Select the Transitions tab and choose a transition. 



 

 

Select a transition to see a preview. 

Select Effect Options to choose the direction and nature of the transition. 

Select Preview to see what the transition looks like. 

To remove a transition, select Transitions > None. 

 

ANIMATION EFFECT 

In PowerPoint, you can animate text and objects such as clip art, shapes, and pictures. 

Animation—or movement—on the slide can be used to draw the audience's attention to 

specific content or to make the slide easier to read. 

The four types of animations 

There are several animation effects you can choose from, and they are organized into four types. 

 Entrance: These control how the object enters the slide. For example, with 

the Bounce animation the object will "fall" onto the slide and then bounce 

several times. 

Emphasis: These animations occur while the object is on the slide, often triggered by a mouse 

click. For example, you can set an object to spin when you click the mouse. 

Exit: These control how the object exits the slide. For example, with the Fade animation the 

object will simply fade away. 

Motion Paths: These are similar to Emphasis effects, except the object moves within the slide 

along a predetermined path, like a circle. 

To apply an animation to an object: 

1. Select the object you want to animate. 

On the Animations tab, click the More drop-down arrow in the Animation group. 

A drop-down menu of animation effects will appear. Select the desired effect. 

The effect will apply to the object. The object will have a small number next to it to show that it 

has an animation. In the Slide pane, a star symbol also will appear next to the slide. 

At the bottom of the menu, you can access even more effects.  

EFFECT OPTIONS 

Some effects will have options you can change. For example, with the Fly In effect you can 

control which direction the object comes from. These options can be accessed from the Effect 

Options command in the Animation group. 



 

 

To remove an animation: 

1. Select the small number located next to the animated object. 

2. Press the Delete key. The animation will be deleted. 

Animations are best used in moderation. Adding too many animations can make your 

presentation look a little silly and can even be distracting to your audience. Consider using 

mostly subtle animations, or not using animations at all. 

Working with animations 

To add multiple animations to an object: 

If you select a new animation from the the menu in the Animation group, it will replace the 

object's current animation. However, you'll sometimes want to place more than one 

animation on an object, like an Entrance and an Exit effect. To do this, you'll need to use 

the Add Animation command, which will allow you to keep your current animations while 

adding new ones. 

1. Select an object. 

2. Click the Animations tab. 

3. In the Advanced Animation group, click the Add Animation command to view 

the available animations. 

4. Select the desired animation effect.  

5. If the object has more than one effect, it will have a different number for each 

effect. The numbers indicate the order in which the effects will occur. 

To reorder the animations: 

1. Select the number of the effect you want to change. 

2. From the Animations tab, click the Move Earlier or Move Later commands to 

change the ordering. 

 



 

 

To copy animations with the Animation Painter: 

In some cases, you may want to apply the same effects to more than one object. You can do this 

by copying the effects from one object to another using the Animation Painter. In our example, 

we want to copy an animation from one slide to another because they have similar layouts. 

1. Click the object that has the effects you want to copy. In our example, we'll click 

our answer text. 

2. From the Animations tab, click the Animation Painter command. 

 

3. Click the object you want to copy the effects to. In our example, we'll click the 

answer text on the next slide. Both objects now have the same effect. 

To preview animations: 

Any animation effects you have applied will show up when you play the slide show. However, 

you can also quickly preview the animations for the current slide without viewing the slide 

show. 

1. Navigate to the slide you want to preview. 

2. From the Animations tab, click the Preview command. The animations for the 

current slide will play. 

 

The Animation Pane 

The Animation Pane allows you to view and manage all of the effects that are on the current 

slide. You can modify and reorder effects directly from the Animation Pane, which is especially 

useful when you have several effects. 



 

 

To open the Animation Pane: 

1. From the Animations tab, click the Animation Pane command. 

 

2. The Animation Pane will open on the right side of the window. It will show all of 

the effects for the current slide in the order in which they will appear. 

 

If you have several animated objects, it may help to rename the objects before reordering them in 

the Animation Pane. You can rename them in the Selection Pane. To open the Selection Pane, 

click an object, then from the Format tab click Selection Pane. Double-click the name of an 



 

 

object to rename it.

 



 

 

To reorder effects from the Animation Pane: 

1. On the Animation Pane, click and drag an effect up or down. 

 

2. The effects will reorder themselves. 

To preview effects from the Animation Pane: 

1. From the Animation Pane, click the Play button. 

 

2. The effects for the current slide will play. On the right side of the Animation 

Pane, you will be able to see a timeline that shows the progress through each 

effect. 



 

 

 

If the timeline is not visible, click the drop-down arrow for an effect, then select Show 

Advanced Timeline. 

 



 

 

To change an effect's start option: 

By default, an effect starts playing when you click the mouse during a slide show. If you have 

multiple effects, you will need to click multiple times to start each effect individually. However, 

by changing the start option for each effect, you can have effects that automatically play at the 

same time or one after the other. 

1. From the Animation Pane, select an effect. A drop-down arrow will appear next 

to the effect. 

 

2. Click the drop-down arrow and select one of the three desired start options. Start 

on Click will start the effect when the mouse is clicked, Start With 

Previous will start the effect at the same time as the previous effect, and Start 



 

 

After Previous will start the effect when the previous effect ends. 

 

When you preview the animations, all of the effects will play through automatically. To test 

effects that are set to Start on Click, you will need to play the slide show. 

The Effect Options dialog box 

From the Animation Pane, you can access the Effect Options dialog box, which contains more 

advanced options you can use to fine tune your animations. 

To open the Effect Options dialog box: 

1. From the Animation Pane, select an effect. A drop-down arrow will appear next 

to the effect. 

2. Click the drop-down arrow, then select Effect Options. 



 

 

 

3. The Effect Options dialog box will appear. Click the drop-down menus and select 

the desired enhancement. You can add a sound to the animation, add an 

effect after the animation is over, or animate text in a different sequence. 

 



 

 

Some effects have additional options you can change. These will vary depending on which 

effect you have selected. 

To change the effect timing: 

1. From the Effect Options dialog box, select the Timing tab. 

 

2. From here, you can add a delay before the effect starts, change the duration of 

the effect, and control whether the effect repeats. 

 



 

 

Challenge! 

1. Open our practice presentation. If you already downloaded our presentation in 

order to follow along with the lesson, be sure to download a fresh copy. 

2. On slide 2, select the text box that contains Answer: Neil Armstrong, and add 

a Pulse animation from the Emphasis group. 

3. In the same text box, add a Wipe animation from Entrance group. 

4. Change the Effect Options so it wipes From Left. 

5. Reorder the animations so the Wipe animation will happen first. 

6. Change the Start options for the Pulse animation so it starts After Previous. 

7. Use the Animation Painter to copy your animations to the Answer: 

Mercury text box on slide 3. 

8. Remove the animations from the text box on slide 3 containing What planet is 

closest to the sun? 

9. When you're finished, play your presentation. Slides 2 and 3 should look 

something like this: 

Apply multiple animation effects to one object 
 Select the object on the slide that you want to animate. 

 On the Animations tab, click Animation Pane. 

 Click Add Animation, and pick an animation effect. 

 To apply additional animation effects to the same object, select it, click Add Animation and 

pick another animation effect.  

 

 

**** 
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